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About this guide

A CAUTION! ABBREVIATED SAFETY ALERTS. Hazard symbols and hazard
types specified in procedures may be abbreviated in this document. For the
complete safety information, see the “Safety” appendix in this document.

IMPORTANT! Before using this product, read and understand the information in the
“Safety” appendix in this document.

About the HRM example experiments

For the purpose of explanation, this guide uses three example experiments to
familiarize you with the process of setting up, performing, and analyzing high
resolution melt experiments performed on the Applied Biosystems™ QuantStudio™ 3
or 5 Real-Time PCR Instrument. The example melt curve experiments are very basic
and intended for instructional purposes only. The experiments employ MeltDoctor™
High-Resolution Melting (HRM) reagents and controls, which are available from
Thermo Fisher Scientific. When designing and performing your own HRM
experiments, adjust the reaction volumes and experiment parameters (controls, dyes,
and PCR method) appropriate for your chosen materials and application.

Tips for running your own HRM experiment

This guide contains instructions specific to the HRM example experiment. It also
functions as a guide for your own experiments; tips for running your own
experiments are provided at various points.

Applied Biosystems™ High-Resolution Melt Getting Started Guide 7



HRM Experiment Overview

About HRM experiments .............. ... ... ... . i 8
HRM experiment workflows ............ ... ... ... ... 9
Materialsand reagents .............. ... ... 12
Required instruments and software .............. ... ... .. ..ol 13

About HRM experiments

HRM controls

High Resolution Melt (HRM) analysis is a post-PCR analysis method used for
identifying genetic variation in nucleic acid sequences. Simple and fast, this method is
based on PCR melt (dissociation) curve techniques and is enabled by the recent
availability of improved double-stranded DNA (dsDNA)-binding dyes along with
next-generation real-time PCR instrumentation and analysis software. HRM analysis
can discriminate DNA sequences based on their composition, length, GC content, or
strand complementarity.

The Applied Biosystems™ qPCR Analysis Software can perform:

Mutation scanning experiments — Screen DNA samples for new single-base
changes, insertions/deletions, or other unknown mutations. The mutation
scanning experiment product can be used for subsequent sequencing reactions.

Methylation studies — Determine the percentage of methylated DNA in
unknown samples.

Genotyping experiments — Determine the genotype of a DNA sample.

For all types of experiments, the Applied Biosystems™ qPCR Analysis Software
compares the melt curves of unknown samples against the melt curves of positive
controls to identify groups of variants.

The type of sample used as the positive controls depends on the type of experiment:

Mutation scanning experiments — One or more samples with the wild type
sequence are used as the control. For unknowns, the call is either “wild type” (if
it matches the control) or “variant X”.

Methylation studies — Methylated DNA standards that contain from 0% to 100%
methylated DNA are used as the positive controls. The software identifies the
percentage methylation of the variants based on their comparison to the
standards.

Genotyping experiments — Three samples are used as controls: one homozygous
for Allele 1, one homozygous for Allele 2, and one heterozygous for both alleles
(Allele 1 and Allele 2). The software identifies the genotypes of the unknown
variants.

Applied Biosystems™ High-Resolution Melt Getting Started Guide



Chapter 1 HRM Experiment Overview
HRM experiment workflows

HRM experiment workflows

The following workflows illustrate the steps for performing a high-resolution melt
curve experiment using MeltDoctor™ HRM Reagents on an Applied Biosystems™

QuantStudio™ 3 or 5 Real-Time PCR Instrument followed by analysis using the
Applied Biosystems™ qPCR Analysis Software on the ThermoFisher Cloud.

Genotyping The following figure illustrates the general workflow for performing genotyping
workflow experiments using high resolution melt curve reagents and the QuantStudio™ 3 or 5
Instrument.

Calibrate your instrument
Prepare a MeltDoctor" HRM calibration plate
v
Perform the HRM calibration
A 4

Design the HRM experiment
Design and order the primers
v
Identify your controls
v

Create the experiment, including targets, samples, controls, and run
method

v

Perform the experiment
Prepare the HRM reactions for the example experiment
v
Load the plate and start the run
v
Monitor the run

v

Analyze the data
Create a project and add experiment data

v

Review and [if necessary) edit the sample, target, task, and control
assignments

v
Review the results of the analysis and adjust the settings (if necessary)

v
Publish the project data
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Chapter 1 HRM Experiment Overview
HRM experiment workflows

Methylation study The following figure illustrates the general workflow for performing methylation

workflow study experiments using high resolution melt curve reagents and the QuantStudio™ 3
or 5 Instrument.
Calibrate your instrument
Prepare a MeltDoctor™ HRM calibration plate
v
Perform the HRM calibration
v

Design your HRM experiment
Design and order the primers
v
Identify your controls and standards
A 4

Create the experiment, including targets, samples, controls, standards,
and run method

v

Perform the experiment
Prepare the HRM reactions for the example experiment
v
Load the plate and start the run
v
Monitor the run
v

Review Experiment Results and Adjust Parameters
Create a project and add experiment data
v
(Optional) Add and define samples and targets
v
Review/edit the sample, target, task, and control assignments
v
Review the results of the analysis and adjust the settings (if necessary)
v
Publish the project data
v

Sequence the variants
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Mutation detection

workflow

Chapter 1 HRM Experiment Overview
HRM experiment workflows

The following figure illustrates the general workflow for performing mutation-
screening experiments using high resolution melt curve reagents and the
QuantStudio™ 3 or 5 Instrument.
Calibrate your instrument
Prepare a MeltDoctor™ HRM calibration plate
v
Perform the HRM calibration
v

Design your HRM experiment
Design and order the primers
v
Identify your controls
\ 4

Create the experiment, including targets, samples, controls, and run
method

v

Perform the experiment
Prepare the HRM reactions for the example experiment
v
Load the plate and start the run
v
Monitor the run
v

Review Experiment Results and Adjust Parameters
Create a project and add experiment data
v
(Optional) Add and define samples and targets
v
Review/edit the sample, target, task, and control assignments
v
Review the results of the analysis and adjust the settings (if necessary)
v
Publish the project data
v

Sequence the variants
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Chapter 1 HRM Experiment Overview

Materials and reagents

Materials and reagents

High-resolution
melt (HRM) dyes

High-Resolution
Melt (HRM)
reagents and
controls

12

The melt profile of a PCR product is best obtained with high-resolution melt dyes
(HRM dyes). HRM dyes are double-stranded dsDNA-binding dyes that have high
fluorescence when bound to dsDNA and low fluorescence in the unbound state. HRM
analysis uses dsDNA-binding dyes that are brighter than those previously used, and
they do not inhibit PCR at high-dye concentrations. With traditional dyes (for
example, SYBR™ Green I dye), only limited concentrations of the dye can be used
before the dye inhibits the PCR.

Custom HRM dyes

This getting started guide describes procedures for calibrating your instrument and
performing HRM experiments using the MeltDoctor™ HRM Dye. If you use a different
HRM dye, prepare a custom HRM calibration plate and then calibrate your
instrument for that dye (see your instrument user documentation for the calibration
procedure). When the instrument is calibrated, follow the procedures provided, but

™

replace the MeltDoctor ™ HRM Dye with your own.

Note: See the High-Resolution Melt Curve Getting Started Guide for your QuantStudio™
3 or 5 Instrument for instructions on performing a custom HRM dye calibration.

Note: Optimize your reactions for the HRM dye that you use, because each dye
interacts uniquely with all other reaction components.

The example experiments described in this document include the following Applied
Biosystems™ MeltDoctor™ High-Resolution Melting (HRM) reagents and controls that
can be used in your own experiments. For product details and ordering information,
visit: http://www.thermofisher.com/us/en/home/life-science/pcr/real-time-pcr/
real-time-pcr-reagents/meltdoctor-hrm-reagents.html

e Applied Biosystems™ MeltDoctor™ HRM Master Mix contains all PCR
components (excluding template and primers) and has been formulated for
optimal HRM performance across a wide range of genomic targets. It features a
dNTP blend that includes dUTP, which minimizes carryover contamination by
allowing amplicon degradation by uracil DNA glycosylase (UDG) in subsequent
PCR reactions. The MeltDoctor™ HRM Master Mix does not require additional
mixing prior to use, and was developed and optimized solely for HRM
applications.

* Applied Biosystems™ MeltDoctor™ HRM Positive Control Kit provides nucleic
acid controls that can be used to demonstrate and troubleshoot high resolution
melt (HRM) analysis. The kit contains forward and reverse primers and three
DNA templates representing the homozygous and heterozygous genotypes for a
[B-actin target gene (ACTB).

* Applied Biosystems™ MeltDoctor™ HRM Calibration Standard contains a DNA
template and primers which, when mixed with PCR reagents and dye, can be
used to prepare a plate for thermal and optical High Resolution Melt (HRM)
calibration for the MeltDoctor™ HRM (High Resolution Melting) dye.

e Applied Biosystems™ MeltDoctor™ HRM Calibration Plates contain all the
components required for dye and HRM calibration on the Applied Biosystems™
QuantStudio™ 3 or 5 Real-Time PCR Instrument. These plates provide the
thermal and optical calibration required for accurate and reproducible

discrimination between melt curves.

Applied Biosystems™ High-Resolution Melt Getting Started Guide
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Chapter 1 HRM Experiment Overview
Required instruments and software

Required instruments and software

Compatible real-
time gPCR
instruments

About the Thermo
Fisher Cloud and
Applied
Biosystems" HRM
Analysis Module

This guide describes how to calibrate, set up, and perform high resolution melt
experiments on the Applied Biosystems™ QuantStudio™ 3 or 5 Real-Time PCR
Instrument. For instructions on performing HRM experiments on other real-time
qPCR instruments manufactured by Thermo Fisher Scientific, refer to the high
resolution melt documentation available from the Thermo Fisher Scientific website
(http://www.thermofisher.com/support).

™

IMPORTANT! QuantStudio™ 3 or 5 Instrument firmware version 1.1 or later is
required to perform HRM experiments.

™

The high resolution melt curve data generated by QuantStudio™ 3 and 5 Real-Time
PCR Systems is analyzed using the Applied Biosystems™ HRM Analysis Module
available through the Thermo Fisher Cloud. The Thermo Fisher Cloud is a secure
suite of cloud computing applications that provide storage and sharing of data
generated on Applied Biosystems™ real-time PCR and capillary electrophoresis
instruments. It seamlessly integrates data management and sharing (Thermo Fisher
Cloud Storage), online analysis modules, and subscription-based access (Subscription
Manager). Using the Thermo Fisher Cloud, you can store, access, analyze, and share
results anytime and anywhere.

Note: Refer to http://www.thermofisher.com/support for answers to questions about
Thermo Fisher Cloud security, including network access, data retention, and user
authorization or authentication.

Note: As an alternative to using the Thermo Fisher Cloud or the Applied
Biosystems™ HRM Analysis Module as described in this guide, you can use the
Applied Biosystems™ High Resolution Melt Software v3.1 (Cat. No. A29881) to
analyze your HRM experiments. The High Resolution Melt Software is a Windows'
compatible desktop application that performs high resolution melt (HRM) analysis of
experiments generated by Applied Biosystems™ Real-Time PCR Systems, including
the QuantStudio™ 3 and 5 Real-Time PCR Systems.

M

System requirements

Web Browser M|n|n'.|um Latest vgrlfled 0S Compatibility
version version
Microsoft™ Internet Explorer” 10.x 10.x Windows" 7.1+
N N Windows™ XP+
Google Chrome 25.x 42.x
0SX 10.6+
" ™ 6: 0SX 10.7+
Apple” Safari” (0SX) 7.x 8.x
7: 0SX 10.9+
" N Windows™ XP SP2+
Mozilla~ Firefox 16.x 36.x
0SX 10.6+

Applied Biosystems™ High-Resolution Melt Getting Started Guide 13
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About the HRM calibration

14

You must calibrate your instrument for the HRM Dye before you can perform high
resolution melting experiments. During the HRM calibration, the Applied
Biosystems™ QuantStudio™ 3 or 5 Real-Time PCR Instrument amplifies the template
in the HRM calibration consumable and performs a melt curve analysis of the PCR
product. We recommend that you calibrate your instrument for each HRM dye that
you are using or for each significant change in master mix composition.

IMPORTANT! If you are using a third-party HRM dye, perform a custom dye
calibration for the HRM dye before you perform the HRM calibration. For more
information on the custom dye calibration procedure, see the user documentation for
your Applied Biosystems™ QuantStudio™ 3 or 5 Real-Time PCR Instrument.

Note: If you are using a third-party HRM dye:

- Prepare the calibration plate as described in this document, but adjust the HRM
dye volumes according to the manufacturer’s instructions.

- You might need to optimize your HRM reactions to account for differences in
sensitivity resulting from the interaction between the dye and reaction components.

Applied Biosystems™ High-Resolution Melt Getting Started Guide



Chapter 2 Calibrate your instrument
Prepare a pre-loaded HRM calibration plate

Prepare a pre-loaded HRM calibration plate

Required
materials

Calibration
guidelines

Prepare the
MeltDoctor” HRM
calibration plate

IMPORTANT! The region of interest, background, and uniformity calibrations must
be current on your Applied Biosystems™ QuantStudio™ 3 or 5 Real-Time PCR
Instrument before you can perform an HRM calibration. For more information on
instrument calibration, see the user documentation for your instrument.

IMPORTANT! Perform a background calibration immediately before you perform the
HRM calibration.

Centrifuge with plate adaptor

Powder-free gloves

Safety goggles

MeltDoctor " HRM Calibration Plate, 0.1-mL ,96- or 384-well

or
MeltDoctor  HRM Calibration Standard, 0.2-mL, 96-well

Wear appropriate protective eyewear, clothing, and gloves.

Prepare and run calibration plates within 120 minutes after thawing them.

Note: Calibration consumables cannot be frozen again and reused.
Store calibration plates in a dark place until you are ready to use them.
Do not let the bottoms of the plates to become dirty.

Confirm that your centrifuge is clean. Before centrifugation, wipe down the
bucket(s) using a tissue.

Vortex and centrifuge all calibration plates to ensure complete mixing and that all
reagents are contained at the bottom of the wells. The calibration plates must be
well mixed and centrifuged before use.

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare the
plate.

1.

™

Remove the MeltDoctor™ HRM Calibration Plate from the freezer, then thaw it at
room temperature for approximately 30 minutes.

IMPORTANT! Use the MeltDoctor™ HRM Calibration Plate within 2 hours of
defrosting it. Until you are ready to run the MeltDoctor™ HRM Calibration Plate,
store it in the dark and at ambient temperature (15°C to 30°C). Do not remove the

plate from its packaging until you are ready to run it.

™

Remove the MeltDoctor™ HRM Calibration Plate from its packaging. Do not
remove the optical film.

3. Vortex and centrifuge the MeltDoctor™ HRM Calibration Plate:

a. Vortex the MeltDoctor™ HRM Calibration Plate for 5 seconds.

Applied Biosystems™ High-Resolution Melt Getting Started Guide 15



Chapter 2 Calibrate your instrument
Perform the HRM calibration

™

b. Centrifuge the MeltDoctor™ HRM Calibration Plate for 2 minutes at
<1500 rpm.

IMPORTANT! The MeltDoctor™ HRM Calibration Plate must be well mixed
and centrifuged.

c. Confirm that the liquid in each well of the MeltDoctor™ HRM Calibration
Plate is at the bottom of the well. If not, centrifuge the plate again at a higher
rpm and for a longer period.

Perform the HRM calibration

Perform an HRM calibration to collect information that the software uses when
analyzing data from a High Resolution Melt experiment.

IMPORTANT! Calibrate the instrument at the same ambient temperature at which
you will run experiments. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and, in extreme cases, influence experimental
results.

1. In the home screen, touch Settings » Maintenance and
Service » Calibrations » Custom » Custom Melt.

2. Touch PCR + Melt or Melt only as appropriate for the dye that you are using.
Note: Select PCR + Melt protocol if you are performing a calibration using
MeltDoctor™ reagents.

3. Select or add a dye, then select a filter set (see filter-wavelength table in step 8
below).

Note: Only the data points obtained by the selected filter set are used for
calibration.

Note: If using the SYBR™ Green dsDNA binding dye, the dye-DNA complex
absorption maxima is 497 nm and the emission spectra maxima is 520 nm. If you
are using a third-party HRM dye, refer to the manufacturer's documentation to
determine the correct filter set for your dye.

4. (Optional) Touch Reagents, then enter reagent information.

5. Load the plate.

a. Touch & to eject the instrument drawer.

16 Applied Biosystems™ High-Resolution Melt Getting Started Guide



b. Load the plate onto the plate adaptor so that:

Chapter 2 Calibrate your instrument

Perform the HRM calibration

e Well Al of the plate is in the top-left corner of the plate adapter.

e The barcode faces the front of the instrument.

IMPORTANT! Plates should be loaded and unloaded by trained operators

who have been warned of the moving parts hazard.

Note: (For 96-well 0.2-mL blocks only) Do not remove the black plate adapter
before loading a plate or strip tubes. Strip tubes may fit loosely in the
adapter, but when the drawer closes, the heated cover will apply the
appropriate pressure to seat the tube strips securely in the adapter.

Note: The 384-well and 96-well Fast (0.1-mL) block configurations do not

require a plate adapter.

c. Touch 4 to close the instrument drawer.

6. Touch Start.

7. When the run is complete and the screen displays Calibration Complete, touch

View Results » Details to check the calibration status.

8. Review the plot. Passing calibration results show uniform signals with peaks

aligned with the dye's wavelength.

Peak channel

Filter wavelength (nm)"]

Excitation Emission
x1-m1 470+ 15 520+ 15
x2-m2 520+ 10 558 +12
x3-m3 550+ 10 587 + 10
Xb-mk 580+ 10 623+ 14

Applied Biosystems™ High-Resolution Melt Getting Started Guide
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Chapter 2 Calibrate your instrument
Perform the HRM calibration

Filter wavelength (nm)!!]
Peak channel
Excitation Emission
x5-mb5 640+ 10 682+ 14
x6-mb 662+ 10 711+ 12

01 The central wavelengths are the optimized wavelengths.

Note: Example dye calibration plot.
The peaks for your dye may align with a different filter set.

9. Select an action depending on whether you determine the custom dye calibration
passed or failed.

Calibration status Action

Passed e Touch Accept Results or Reject Results.
Note: Accepting the results saves the calibration data to
the instrument and overwrites existing data.

* (Optional) Touch Transfer Eds to transfer the calibration
data to a USB.

Failed * Create another custom dye plate using the next dye
concentration greater than the concentration determined
in Determine the optimal dye concentration, then perform
the calibration again.

e Troubleshoot the failed calibration as explained in this
guide.

10. Unload the plate.
a. Touch & to eject the instrument drawer.

b. Remove the plate.

c. Touch 4 to close the instrument drawer.

ii CAUTION! PHYSICAL INJURY HAZARD. During instrument operation,
the plate temperature can reach 100°C. Allow it to cool to room
temperature before handling.

Note: If the instrument does not eject the plate, contact Support.

11. Discard the calibration plate.

Applied Biosystems™ High-Resolution Melt Getting Started Guide



Chapter 2 Calibrate your instrument
Perform the HRM calibration

You must add the custom dye to the desktop or cloud software dye libraries before
creating, running, or analyzing experiments that use custom dyes. Refer to the
QuantStudio” Design and Analysis desktop Software User Guide (Pub. no. MAN0010408)
or the QuantStudio ~ Design and Analysis cloud Software Help (Pub. no. MAN(0010414).

IMPORTANT! When specifying a custom dye (or creating a new dye), the name of the
dye that you create must match the dye specified during the Experiment Setup (in the
Design & Analysis Application Module).

Applied Biosystems™ High-Resolution Melt Getting Started Guide 19
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Experiment workflow

The following workflows illustrate the general steps required to perform a high-

Chapter 3 Prepare the HRM reactions and perform the experiment
Experiment workflow

resolution melt curve experiments using MeltDoctor™ HRM Reagents on an Applied

™

Biosystems™ Real- Time PCR System.

Required materials

Calibrate your instrument
v

Design the HRM experiment
Design and order the primers
v
Identify your controls
v
(Methylation study only} Identify your standards
v

Create the experiment on the QuantStudio™ 3 or 5 Instrument,
including targets, samples, standards, and run method

v

Perform the experiment
Prepare the HRM reactions for the example experiment
v
Load the plate and start the run
v
Monitor the run

v

Analyze the data
v

Sequence the variants

* Microcentrifuge tubes

¢ Optical reaction plate appropriate for your real-time PCR instrument
e MicroAmp  Optical Adhesive Film
e MeltDoctor " HRM Master Mix

e Deionized water

* Pipettors and pipette tips

e Vortexer

¢ Centrifuge

Applied Biosystems™ High-Resolution Melt Getting Started Guide
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Chapter 3 Prepare the HRM reactions and perform the experiment

Design primers

* For each target sequence:

— Forward and reverse primers (5 uM each)
— DNA samples
* (Methylation study only) Methylated DNA standards

* (Genotyping only) Positive controls appropriate for your experiment

IMPORTANT! If you use HRM reagents from another manufacturer, you must
calibrate your QuantStudio " 3 or 5 Instrument using those dyes.

Note: For the purpose of explanation, the example experiment described in this
guide uses the MeltDoctor HRM Positive Control Kit, which includes the
following controls:

- MeltDoctor  HRM Primer Mix (20X)

- MeltDoctor  HRM Allele A DNA (20X)

- MeltDoctor  HRM Allele G DNA (20X)

- MeltDoctor  HRM Allele A/G DNA (20X)

Design primers

™

Primer design for Note: If you are using the MeltDoctor™ HRM Positive Control Kit to run the example
genotyping experiment, you do not need to design primers because the kit contains primers
designed to amplify the alleles in the positive control DNA.

Using Primer Express™ Software v3.0 or later, design the primers to amplify the
sequence of interest. HPLC-purified primers are recommended for best performance,
although desalted primers are usable in some cases.

We recommend using these guidelines when designing primers:

Design attribute

Design guidelines

Amplicon

e Length is 60 to 250 basepairs (longer amplicons may require
optimization)

e Contains only one SNP

e Does not contain a repeating element

e Corresponds to a unique sequence within the sample

Primer length

~20 bases each

Tm

58°C to 60°C (Optimal Tm is 59°C)

% GC content

30-80% GC content in each primer

3'end

No more than two G+C residues in the last five nucleotides at the
3'end

Repeating
oligonucleotides

Avoid consecutive identical nucleotides. If you are unable to avoid
consecutive identical nucleotides, make sure that each primer
contains fewer than four consecutive Gs. Also, make sure that the
amplicon does not contain a repeating element.

22
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Primer design for
methylation
studies

Chapter 3 Prepare the HRM reactions and perform the experiment
Design primers

Using Primer Express™ Software v3.0 or later, design the primers to amplify the
genomic DNA that spans the mutations of interest. Order the primers from the
Thermo Fisher Scientific Store.

Design the primers so that they meet these guidelines:

Design attribute Design guidelines

Amplicon e Length is less than 250 basepairs
e Does not contain a repeating element

e Corresponds to a unique sequence within the sample

Primer length ~20 bases each

Tm 58°C to 60°C (Optimal Tm is 59°C)

% GC content 30-80% GC content in each primer

3’ end No more than two G+C residues in the last five nucleotides at the
3’ end
Repeating Avoid consecutive identical nucleotides. If you are unable to avoid

oligonucleotides | consecutive identical nucleotides, make sure that each primer
contains fewer than four consecutive Gs. Also, make sure that the

amplicon does not contain a repeating element.

If you want to use M13F and M13R primers in the sequencing reaction, add the
appropriate M13 tail to the 5" end of the primers:

* MI13F (add to the 5" end of the forward primer):

1 TGTAAAACGA CGGCCAGT

¢ MI13R (add to the 5" end of the reverse primer):

1 CAGGAAACAG CTATGACC

™ ™

Using Applied Biosystems™ Methyl Primer Express™ Software, design the primers to
amplify the genomic DNA that spans the methylation sites of interest. With Methyl
Primer Express™ Software, you can specify the number of CpG dinucleotides to
include in the PCR primers and their position. Order the primers from the Thermo
Fisher Scientific Store.

Design attribute Design guidelines

Amplicon e Length is less than 250 basepairs
e Does not contain a repeating element
e Corresponds to a unique sequence within the sample

e To detect high levels of methylation, primers lie outside of the
CpGisland

e To detect low levels of methylation, primer sequences include
CpG dinucleotides

Primer length ~20 bases each

m 58°C to 60°C (Optimal Tm is 59°C)

Applied Biosystems™ High-Resolution Melt Getting Started Guide 23



Chapter 3 Prepare the HRM reactions and perform the experiment
Choose experiment controls

Design attribute Design guidelines

% GC content 30-80% GC content in each primer 3’ end No more than two G+C
residues in the last five nucleotides at the 3’ end

Repeating Avoid consecutive identical nucleotides. If you are unable to avoid
oligonucleotides | consecutive identical nucleotides, make sure that each primer
contains fewer than four consecutive Gs. Also, make sure that the
amplicon does not contain a repeating element.

Choose experiment controls

When designing your experiment, consider the use of controls appropriate for your
application. The following table describes the recommended controls for high
resolution melt curve experiments performed on the QuantStudio™ 3 or 5 Instrument.

Experiment type Recommendation

Include controls for each target sequence in your genotyping
experiment.

e At least one negative control

e At least one positive control to represent each expected
Genotyping variant

Run 3-5 replicates of each control to improve your results.
Running multiple positive controls allows you to more effectively
define the natural spread or variation within different samples of
the same sequence, or within replicates of the same genotype

Include controls for each target sequence in your mutation
detection experiment:

e At least one negative control

e At least one wild type control

Run up to 5 replicates for each wild type control to improve
your results. Running multiple wild type controls allows you
to more effectively define the natural spread or variation
within the normal population.

Mutation detection

Including controls for each target sequence in your methylation
study:
Methylation study e At least one negative control

e Methylated DNA standards that contain from 0% to 100%
methylated DNA
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Prepare the standards

Prepare the
methylated DNA
standards

Treat the samples
and methylated
DNA standards
with bisulfite

Prepare the standards

If you are performing a methylation study, prepare the methylated DNA standards

prior to plating the reactions.

1. Obtain universally methylated DNA to represent DNA that is 100% methylated.

2. Select DNA that is non-methylated to represent DNA that is 0% methylated.

3. Mix different ratios of 100% methylated and 0% methylated DNA of equal

concentration. For example:

DNA Volume to prepare the methylated DNA standard
100% methylated DNA (20 0pL | 7.5pL Syl 2.5uL 1uL 0L
ng/uL)
Non-methylated DNA (20 OpuL 2.5uL 5uL 7.5 puL 9 uL 10 yL
ng/uL)
% methylated DNA 100% 75% 50% 25% 10% 0%

Note: To detect low levels of methylation, add more standards between 0% and
2% methylation. For example, prepare standards to represent 0.0%, 0.1%, 0.5%,

1%, 2%, 5%, 10%, and 100% methylation.

Before you perform the HRM reactions for your methylation study, treat your samples
and methylated DNA standards with bisulfite to convert non-methylated cytosines
(C) in your DNA to uracil (U). Samples that vary in the number of U residues within

the amplified sequence will have distinct melt curve shapes and Tm values.

™

We recommend that you use the Cells-to-CpG™ Bisulfite Conversion Kit
(Cat. no. 4445555). For instructions, refer to the Applied Biosystems™ Cells-to-CpG"™

Bisulfite Conversion Kit Protocol (Pub. no. 4448998).

Applied Biosystems™ High-Resolution Melt Getting Started Guide
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Prepare the reactions

Prepare the reactions

Prepare the reactions for each replicate group separately, then transfer the reactions to
a reaction plate appropriate for your instrument.

1. Prepare the negative control reactions in an appropriately sized, labeled tube:

Volume (pL)
384-well plate 96-well plate
Components 3 replicates 3 replicates
1 reaction plus 10% 1 reaction plus 10%

excess excess
MeltDoctor” HRM Master 10.0 33.00 25.0 82.5
Mix
Primer 1 (5 uM) 1.2 3.96 3.0 9.9
Primer 2 (5 uM) 1.2 3.96 3.0 9.9
Deionized water 7.6 25.08 19.0 62.7
Total volume 20.0 66.0 50.0 165.0

IMPORTANT! Include excess volume in your calculations to provide excess
volume for the loss that occurs during reagent transfers. We recommend an

excess volume of at least 10%.

2. Prepare positive control, standard, and unknown reactions in separate
appropriately sized and labeled tubes:

Volume (pL)
384-well plate 96-well plate
Components 3 replicates 3 replicates
1 reaction plus 10% 1 reaction plus 10%

excess excess
MeltDoctor HRM Master 10.0 33.00 25.0 82.5
Mix
Primer 1 (5 uM] 1.2 3.96 3.0 9.9
Primer 2 (5 uM] 1.2 3.96 3.0 9.9
Genomic DNA (20 ng/uL]) 1.0 3.30 2.5 8.25
Deionized water 6.6 21.78 16.5 54.45
Total volume 20.0 66.0 50.0 165.0

IMPORTANT! Include excess volume in your calculations to provide excess
volume for the loss that occurs during reagent transfers. We recommend an

excess volume of at least 10%.

3. Vortex the reactions to mix, then spin the tubes briefly.
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Perform the HRM experiment

4. Prepare a reaction plate appropriate for your instrument:

a. Pipet each reaction replicate to the appropriate wells of the optical reaction

plate:

Reaction plate Reaction volume
Fast 384-well plate 20 pL
Fast 96-well plate 20 pL
Standard 96-well plate 50 pL

b. Seal the reaction plate with optical adhesive film, then spin the reaction

plate.

c. Confirm that the liquid is at the bottom of the wells in the reaction plate.

Note: If you plan to wait more than 24 hours before running the plate, store the
plate at 4°C. Allow the plate to warm to room temperature, then spin the plate
briefly before running it.

Perform the HRM experiment

Perfor_.m the HRM IMPORTANT! Before you perform high-resolution melt curve experiments on your
experiment Applied Biosystems  QuantStudio " 3 or 5 Real-Time PCR Instrument, you must
perform an HRM calibration.

1. Use the QuantStudio™ Design and Analysis desktop Software to create a melt
curve experiment template, then transfer the file to the QuantStudio™ 3 or 5

Instrument.

For detailed instructions on creating and transferring an experiment template,
refer to the user documentation for your Applied Biosystems™ QuantStudio™ 3
or 5 Real-Time PCR Instrument.

Experiment
properties

Settings

Sample
settings

Create a sample entry for each sample that you are evaluating,
including separate positive controls for each expected variant.

Target settings

Create a target for each amplicon region and assign the dyes.

Note: If you are running multiple assays on your plate, create a
target for each target sequence that you are evaluating. The
Applied Biosystems" qPCR Analysis Software will separate the
wells into different assays according to the target assigned to the
well.

Control
settings

Create and assign the controls used in the experiment (positive
and negative).

e Task for negative control wells: NTC

e Passive Reference: None

Applied Biosystems™ High-Resolution Melt Getting Started Guide
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Perform the HRM experiment

Experlm_ent Settings
properties
Run method Program the experiment with the thermal cycling protocol for your

instrument, including the following experiment properties:

e Thermal Profile: Enter the time and temperature parameters
for the PCR and subsequent melt curve, including both pre-
and post-read data collection (if applicable).

¢ Run Mode: Standard

e Ramp Mode:
- Continuous mode set to 0.025°C/second
or

No. of Data Points per Degree mode set to >10 data
points.

e Sample Volume (pL): 20 (384-well or 96-well Fast) or 50 (96-
well standard)

When in Continuous mode, the instrument uses a fixed ramp rate
for the melt step and captures as many data point as possible
within the time permitted. When in Data point per degree mode,
the instrument adjusts the step and hold for the melt step to
achieve the specified number of data points.

IMPORTANT! If using Data points per degree mode, make sure to
set the ramp mode to collect at least 10 data points per degree
Celsius so that the instrument collects enough data for analysis.

The following table displays the thermal cycling method for performing PCR and

melt curve using MeltDoctor ™ reagents and controls.

Stage Step Temp Time
Holding Enzyme activation 95°C 10 min
Cycling (40 cycles) Denature 95°C 15 sec
Anneal/extend 60 °C 1 min
Melt Denature 95°C 10 sec
curve/dissociation Anncal 40 °C P~
High resolution 95°C 15 sec

melting
Anneal 60°C 15 sec

2. Create an experiment from the template:

™

a. In the home screen of the QuantStudio™ 3 or 5 Instrument, touch a1, Open

Template.
b. (Optional) Touch an experiment category in the left column.

c. Touch an experiment name.
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Perform the HRM experiment

3. Enter the experiment settings:

Note: You can assign HRM experiments on your Applied Biosystems"™
instrument before or after you prepare your HRM reactions.

a. (Optional) Define the experiment properties, including Run File Name (.eds
file name), Plate Barcode, Reagent Information, and Data Destination.

b. (Optional) Edit the run method. Add, remove, or edit a step, stage, melt
curve, or data collection location. Also, adjust the cover temperature, sample
volume, or number of cycles as needed.

c. (Optional) Assign sample names to the plate wells and view Well ID, Targets,
or Dyes.

4. Load the plate.
a. Touch & to eject the instrument drawer.

b. Load the plate onto the plate adaptor so that:
¢ Well Al of the plate is in the top-left corner of the plate adapter.

e The barcode faces the front of the instrument.

IMPORTANT! Plates should be loaded and unloaded by trained operators
who have been warned of the moving parts hazard.

Note: (For 96-well 0.2-mL blocks only) Do not remove the black plate adapter
before loading a plate or strip tubes. Strip tubes may fit loosely in the
adapter, but when the drawer closes, the heated cover will apply the
appropriate pressure to seat the tube strips securely in the adapter.

Note: The 384-well and 96-well Fast (0.1-mL) block configurations do not
require a plate adapter.

c. Touch 4 to close the instrument drawer.

5. Touch Start Run.
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Confirm Note: See the Applied BiosysternsTM QuantStudio " 3 or 5 Real-Time PCR Instrument
amplification and user documentation for instructions on viewing amplification data during the real-

check the run data  tme PCR run.

1. During or immediately following the real-time run, review the amplification data
for normal characteristics:

* Fluorescence levels that exceed the threshold between cycles 8 and 35

¢ An exponential increase in fluorescence

If the Amplification Plot contains abnormalities, see the Applied Biosystems™

™

QuantStudio™ 3 or 5 Real-Time PCR Instrument user documentation for identify
and resolve the problem.

2. Review the amplification data for potential outlier wells with Ct values that
differ from replicates by more than two. Record the location of the outlying wells
on the plate for possible omission during the analysis.

Note: The outliers can produce erroneous HRM results.

Unload the When the run is complete:

instrument and 1

. Unload the plate.
transfer the data

a. Touch & to eject the instrument drawer.
b. Remove the plate.

c. Touch 4 to close the instrument drawer.

ii CAUTION! PHYSICAL INJURY HAZARD. During instrument operation,
the plate temperature can reach 100°C. Allow it to cool to room
temperature before handling.

Note: If the instrument does not eject the plate, contact Support.

2. Transfer the data to the Thermo Fisher Cloud for analysis:

a. In the home screen, touch Transfer File.
b. Touch Cloud, (P USB,or  Network to select the data destination.
c. Navigate to and select your folder destination.

d. Touch OK, then touch Transfer.
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HRM genotyping analysis workflow

The following workflow illustrates the general steps required to perform a high-
resolution melt curve genotyping experiment using MeltDoctor™ HRM Reagents on
an Applied Biosystems™ Real- Time PCR System followed by analysis using the
Applied Biosystems™ qPCR Analysis Software.

Calibrate your instrument

v

Design the HRM experiment

v

Perform the experiment
v

Analyze the data
Create a project and add experiment data
v

Review and [if necessary) edit the sample, target, task, and control
assignments

v
Review the results of the analysis and adjust the settings (if necessary)
v
Publish the project data
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Configure your analysis project

Configure your analysis project

Log into the
Thermo Fisher
Cloud

Create a project
and add
experiment data

32

After you create your HRM project using the Thermo Fisher Cloud and populate it
with experiments, use the Applied Biosystems™ qPCR Analysis Software HRM
Module to correct any experiment settings prior to the analysis.

Note: As an alternative to using the Thermo Fisher Cloud or the Applied
Biosystems™ HRM Analysis Module as described in this guide, you can use the
Applied Biosystems ™ High Resolution Melt Software v3.1 (Cat. No. A29881) to
analyze your HRM experiments. The High Resolution Melt Software is a Windows"'-
compatible desktop application that performs high resolution melt (HRM) analysis of
experiments generated by Applied Biosystems™ Real-Time PCR Systems, including
the QuantStudio™ 3 and 5 Real-Time PCR Systems.

Analysis of the HRM experiment data is performed using the Applied Biosystems
qPCR Analysis Software HRM Module, which is available on the Thermo Fisher
Cloud. The Thermo Fisher Cloud is a cloud storage and applications environment that
provides scientists with a secure location to store, analyze, and share data. If
connected to the internet, you can upload your HRM experiment data directly from
your Applied Biosystems QuantStudio 3 or 5 Real-Time PCR Instrument or upload
the experiment files from anywhere you have web access.

Note: For more information on the Thermo Fisher Cloud, go to https://
www.thermofisher.com/cloud.

To log into the Thermo Fisher Cloud:

* Using an internet browser, go to https://apps.thermofisher.com , then log into the
Thermo Fisher Cloud using your user account and password.

If you do not have a Thermo Fisher Cloud user account, click Create an account,
then follow the on-screen instructions to create an account for your projects. The
Applied Biosystems™ qPCR Analysis Software HRM Module is available from
within the Thermo Fisher Cloud.

1. Click 4 (Manage Projects) to view the Dashboard.

2. Create the project:
a. Click [ New Project.

b. In the Create Project dialog box, enter a name for the project, select the
folder within which you want to place the project, then click OK.

Note: The project name cannot exceed 50 characters and cannot include any
of the following characters: / \ <>*?" | :; & % $@" ()!
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Chapter 4 Analyze an HRM genotyping experiment
Configure your analysis project

3. From the Manage Data screen, add any additional experiment data to the project.

To import
experiment data
stored on...

Action

Your computer

1. Click Import from local.

From the Open dialog box, select one or more experiment
files (.sds or .eds], then click Open.

Note: Ctrl- or Shift-click to select multiple files.

Wait for the Applied Biosystems" Software to upload the
selected data.

. Click Close prompted that the import is complete.

Thermo Fisher
Cloud

1. Click Import from Thermo Fisher Cloud.
. Select one or more experiment files (.sds or .eds) from

the table, then click Add.

. When you are done adding files to the queue, click OK.
. Click Close prompted that the import is complete.

4. Repeat step 3 until your project contains all of the desired experiment data.

5. Click the appropriate analysis module on the left side of the screen to begin the

analysis.

The Applied Biosystems qPCR Analysis Software populates the Overview screen
with the samples and targets present in the experiments added to the project. If
necessary, you can add, edit, or remove the samples and targets as needed before the

analysis.

¢ Create a new sample or target:

a. From the Samples or Targets table in the Overview screen,

click Actions » Add.

b. In the New Sample/Target dialog box, enter a name for the new sample or
target (up to 256 characters), then edit the properties of the new

sample/target.

c. Click OK.

¢ Update an existing sample or target by editing the entry directly in the table.

Note: Alternately, select a sample or target from the table, then

select Actions » Update.

* Delete a sample or target:

a. From the Samples or Targets table in the Overview screen, select the sample
or target of interest, then click Actions » Delete.

b. In the confirmation dialog box, click OK to delete the sample or target.
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Manage HRM The Applied Biosystems  qPCR Analysis Software populates the Overview screen
controls with the controls present in the experiments added to the project.

If necessary, you can add, edit, or remove controls as needed before the analysis:

e Create a new control:

a. From the Controls table in the Overview screen, click Actions » Add.

b. In the New Control dialog box, enter a name for the new control (up to 256
characters), then edit the properties of the new control.

c. Click OK.

¢ Update an existing control by editing the entry directly in the table.

Note: Alternately, select a control from the table, then select Actions » Update.

¢ Delete a control:

a. From the Controls table in the Overview screen, select the control of interest,
then click Actions » Delete.

b. In the confirmation dialog box, click OK to delete the control.

Review and edit After configuring your project with all necessary samples and targets, use the Plate

the plate setups Setup screen to review the experiments for problems that can prevent the analysis of
the project. The Applied Biosystems qPCR Analysis Software displays plate
configuration errors that can prohibit analysis in the margin beneath each image of
the related experiment. Before you can analyze your project, you must use the Plate
Setup screen to address them.

To review the plate setup information for your project:

1. Select Plate Setup to display Plate Setup screen.
2. From the Plate Setup screen, review the experiment records for errors.

3. If errors are present, click the experiment record of interest and address the
problem that is preventing the analysis of the file.

Note: The software displays plate configuration problems that will prevent
analysis of an experiment beneath the image of the related plate.
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Apply samples and targets

If the sample or target assignments of one or more of your experiments contain errors
or are missing, you can use the Applied Biosystems = qPCR Analysis Software to
correct the problem prior to analysis.

Note: When reviewing a plate layout, click Actions » Clear Well Setup to remove the
well information (sample, task, and target assignments) from the selected wells in the
plate grid.

1. From the Plate Setup screen, select the experiment that you want to modify.

2. (Optional) From the Edit Plate screen, click View <@, then select Target and
Sample to color the plate setup according to the element that you intend to
modify.

3. Select the wells of the plate layout to which you want to apply the target or
sample.

4. When the wells are selected, click the appropriate field to the right of the plate
grid, then select the appropriate item from the list.

Note: If you have not yet created a sample or target, enter the name in the
appropriate field and press Enter to create the new sample or target.

5. Once you are finished making changes to the plate layout, click Analyze to
reanalyze your project.

Specify and assign tasks

If the task assignments of one or more of your experiments contain errors or are
missing, you can use the Applied Biosystems qPCR Analysis Software to correct the
problem prior to analysis.

Note: When reviewing a plate layout, click Actions » Clear Well Setup to remove the
well information (sample, task, and target assignments) from the selected wells in the
plate grid.

1. From the Plate Setup screen, select the experiment record that you want to
modify.

2. From the Edit Plate screen, click View @, then select Task to color the plate
setup according to task assignment.

3. Select the wells of the plate layout to which you want to apply a task.
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4. When the wells are selected, click the Task menu, then select the appropriate task
from the list.

Available tasks include:
¢ Unknown - The task for wells that contain a sample with unknown
genotype, variant content, or percentage methylation.

* NTC - The task for wells that contain water or buffer instead of sample (no
template controls). No amplification of the target should occur in negative
control wells.

* Positive Controls - Wells that contain one of the following;:
— A template known to generate a specific genotype call for one or both
alleles (Heterozygote or Homozygote).
- A wild type control (Wild Type).

— Methylated DNA standards that contain from 0% to 100% methylated
DNA (add a custom control label).

Note: The Task/Control dropdown list displays the controls present in the
Controls pane of the Overview screen. See “Manage HRM controls” on
page 34 for information on adding and editing controls.

5. Repeat steps 3 and 4 as needed.

6. Once you have completed making changes to the plate layout, click Analyze to
reanalyze your project.

Review HRM genotyping data

The Applied Biosystems™ qPCR Analysis Software High Resolution Melt module
supports the analysis of HRM genotyping experiments, where melt curve technique is
used to determine the genotype of unknown DNA samples. During the analysis, the
software compares the melt curves of the unknown samples against those generated
from a set of DNA standards (positive controls) that represent the genotypes for the
target sequence (Allele 1 homozygous, Allele 2 homozygous, and Allele 1/Allele 2
heterozygous). Based on the comparison, the software assigns calls to the unknown
samples according to the fit of the unknown melt curves to those of the controls.

In general, review of genotyping results occurs in the following steps:

1. Define the analysis settings, then analyze the project.

2. Perform an initial review of the High Resolution Melt Plots, the Plate Layout, and
the Well Table to evaluate the genotype calls made by the Applied Biosystems™
Software.

3. Perform a thorough review of the QC Summary to evaluate the samples that
triggered QC flags. Review the raw data and amplification data for the samples
that exhibit abnormal amplification.

4. If necessary, adjust the analysis settings or modify the calls manually.

After evaluating the results, publish the analyzed data.
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When a project is created, the Applied Biosystems gqPCR Analysis Software

processes the project data using the default analysis settings of the experiments added

to the project. If desired, you can modify the analysis settings from the Quality
Control & Results screen (for example, manual versus automatic thresholding or
stringent versus relaxed quality thresholds).

1. From the Quality Control & Results screen, select an experiment of interest.
2. From the Review Result screen, click Analysis Settings.

3. From the Edit Analysis Setting dialog box, modify the analysis settings as
desired.

Group

Settings

Target Settings

Select the method (automatic or manual) that the Applied Biosystems™ Software will use to

compute the pre- and post-melt ranges, grouping, and variant removal:

¢ Define whether the pre- and post-melt range for each target will be computed
automatically or manually:

- Auto Set Melt Range - If you are using automatic settings, select the checkbox to

have the software calculate the pre- and post- melt ranges for the specific target.
- Pre-Melt Start/Stop and Post-Melt Start/Stop - If you are using manual settings,

enter the manual pre- and post-range values for the appropriate targets.

¢ Define whether the genotype groups for each target will be determined automatically or

manually:
- Auto Determine # of Groups - If you are using automatic settings, select the
checkbox to have the software calculate the number of groups for the specific
target.

- Number of Groups - If you are using manual settings, enter the number of groups

for the appropriate targets.

¢ Remove all Manual Variants on reanalysis - Select to have the software omit from the

analysis all wells that have been manually been labeled as a variant.

Flag Settings

Specify the quality measures that the Applied Biosystems' Software will compute during the

analysis.

1. In the Use column, select the check boxes for flags you want to apply during analysis.
2. If an attribute, condition, and value are listed for a flag, you can specify the setting for
applying the flag.
For example, with the default setting for the no amplification flag (NOAMP), wells are
flagged if the amplification algorithm result is less than 0.1.

Note: If you choose to adjust the setting for applying a flag, make minor adjustments as

you evaluate the appropriate setting.

3. Inthe Reject Well column, select the check boxes if you want the software to reject
wells with the flag. Rejected wells are not considered for data analysis.

4. When done modifying the analysis settings, click Finish.
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Review HRM genotyping data

Review the quality
data

38

After the Applied Biosystems qPCR Analysis Software processes your project, you
can use the Quality Control & Results screen to review the quality data generated by
the analysis. The software provides a variety of options to review the quality data;
however, the strategy that you employ will depend on the type of experiment you are
performing and the samples/targets that you are evaluating. The following procedure
describes a general approach to data review and provides an overview of the software
features.

1.

2.

3.

If you have not already done so, click Analyze to analyze your project.
Click Quality Control & Results to view the Quality Control & Results screen.

Review the experiment data for quality flags generated during the analysis.

™

Note: The Applied Biosystems™ Software displays summaries of the quality
data in the margin beneath each experiment. You can view the identity of the
triggered flags by mousing over an experiment of interest.

Alternatively, to quickly find the experiments in your project that generated
quality flags, click = (Plate View), then click the Flags column heading to sort
the experiments that generated quality flags to the top of the table. To examine
the data that triggered the flag, click the corresponding link in the Name column.

In response to the presence of quality flags, consider the following resolutions:
* Change the quality settings in the analysis settings:

— Adjust the sensitivity of the quality flags so that more wells or fewer
wells are flagged.

— Deactivate the quality flags that triggered by the data.

* Omit individual wells from the analysis.

If flags or irregularities are present, or you would like to review the melt curve
data for a specific experiment, click the experiment of interest.

When viewing an experiment, display the Well Table:

Tool Use this tool to...

Select wells. To select:
e Anindividual well, select the well in the Well table.

e More than one well at a time, press the Ctrl key or Shift key

Mouse/cursor when you select the wells in the Well table.

When you select wells in the Well table, the corresponding data
points are selected in the amplification plot.

Omit/Un-Omit well from the analysis.

After you omit or un-omit a well, click Analyze to reanalyze the
project.

Actions menu For omitted wells, the software:

* Does not display data in the Well table (data are either
Unknown or empty/blank].

¢ Does not include the omitted wells in the analysis.

d or b Expand or collapse the Well table by clicking the appropriate

symbol in the vertical bar between the plot and table.
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6. Review the data in the Well Table data.

Column Description
The location of the well on the reaction plate. For example, P18 indicates that the sample is
Well )
found in row P, column 18.
Omit The omission status of the related well.
The ID (a unique name or number) of the nucleic acid sequence targeted by the assay added
Target
to the well.
Sample The ID (a unique name or number) of the sample.
Task/Control The task assigned to the well, where the task is the function that a sample performs on the
plate.
Variant The call for the sample in well. Can be assigned by software (Auto) or manually.
Method The method used to apply the call to the well: Auto(matic) if calculated by the Applied

Biosystems" qPCR Analysis Software or Manual if user-applied.

Silhouette Score

The modified silhouette score calculated for the well, which measures distinguishably of the
associated melt curve relative to the other curves in the assay (Rousseeuw, 1987.).

For each melt curve, the software calculates a modified silhouette score, which ranges from
0 to 100. A score closer to 100 indicates that a melt curve is more similar to curves assigned
the same variant call than to curves called differently. Lower silhouette scores indicate that a
melt curve is less similar to curves assigned the same variant call.

IMPORTANT! The modified silhouette score differs from the standard silhouette score
(Lovmar, et. al., 2005.) in that the software assigns the score to each identified cluster

instead of to each data point in the cluster. In addition, the modified value ranges from 0 to
100.

The 1st, 2nd, and 3rd calculated melt temperature (Tm) for the well (if present).

Tm1/Tm2/Tm3 Note: Blank table cells indicate that the software calculated no Tm for the well at the
indicated position.
The amplification status for the well: amplification, no amplification, reviewed, and
Amp Status .
undetermined.
Amp Score The amplification score calculated for the well.
Cq Conf The Cq confidence score calculated for the well.
Ct The Ct calculated for the related well.
Ct Mean The arithmetic mean generated from the Cys calculated for the technical replicates of the
well.
CctSD The standard deviation generated from the Cts calculated for the technical replicates of the
well.
Flags The number of flags generated for the well.
Quality data The quality flags generated by the associated well.

7. When ready, click € to return to the thumbnails view.
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Review the The Aligned Melt Curves plot displays the melt curves as percentage melt (0 - 100%)
controls and over temperature. The melt curves are aligned to the same fluorescence level using the
replicate pre- and post-melt regions that you set.

populations for 1. In the Applied Biosystems™ qPCR Analysis Software, select the Quality Control
outliers & Results tab.

2. In the Quality Control & Results pane, select Plot » Aligned Melt to review the
Aligned Melt Curve Plot.

3. If using positive controls, confirm the calls for the positive controls:

a. From the well table, select the wells containing a positive control to
highlight the corresponding melt curve in the Aligned Melt Curves Plot.

b. Confirm that the color of the line corresponds to the correct genotype.
c. Repeat steps a and b for the wells containing the other positive controls.

4. Screen the negative controls to ensure that samples failed to amplify:

a. From the well table, select the wells containing a negative control to
highlight the corresponding melt curve in the Aligned Melt Curves Plot.

b. Confirm that the selected wells in the well table are negative controls, and
not unknown samples.

Samples that grouped with the negative controls may:
¢ Contain no DNA
¢ Contain PCR inhibitors

* Be homozygous for a sequence deletion

5. Confirm the results of the samples that did not group tightly or are grouped with
negative controls by retesting them.

6. If you select to run replicate reactions, carefully review your data set for curves
that do not align tightly with the other samples in the group (outliers) to ensure
the accuracy of the genotype calls. If outliers are present, confirm the results of
the associated samples by retesting them.

7. Look for how many different variant groups (different colors) are displayed. If
you see more than you were expecting, you may have sample contamination or
may need to modify the analysis settings.

Review the data:

* Variant groups (different colors) - How many different variant groups are
displayed? Does this number correspond to the number of variants you were
expecting?

* Outliers — Are there any curves within a variant group that do not cluster
tightly with the other samples in that group?
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Review and adjust When you analyze an HRM experiment, the software calculates the Pre- and Post-melt

the pre- and post- regions using default settings. You can review and adjust the Pre- and Post-melt

melt regions regions to optimize your separation and variant calls. For most experiments, set the
Pre- and Post-melt regions as close as possible to the melt transition region.

About the pre- and post-melt regions

In the Derivative Melt Curves plot and the Raw Melt Curves plot, there are two pairs
of vertical lines before and after the data peak. These lines define the pre- and post-
melt regions used to scale the data in the Aligned Melt Curves and Difference Plot.

* Pre-melt region — The pair of lines to the left of the peak indicate the pre-melt
Start and Stop temperatures when every amplicon is double-stranded.
Fluorescence data from the pre-melt region corresponds to 100% fluorescence in
the Aligned Melt Curves Plot.

* Active melt region — The data peak indicates the active melt region of the plot.
Data from the active melt region are used to plot the Aligned Melt Curves Plot.

* Post-melt region — The set of lines to the right of the peak indicate the post-melt
Start and Stop temperatures when every amplicon is single-stranded.
Fluorescence data from the post-melt region correspond to 0% fluorescence in the
Aligned Melt Curves Plot.

Review and adjust the pre- and post-melt regions

1. Display the Derivative Plot for the experiment of interest:

™

a. Inthe Applied Biosystems™ qPCR Analysis Software, select the Quality
Control & Results tab.

b. In the Quality Control & Results tab, select an experiment of interest, then
select all wells in the plate grid.

c. Select Plot » Derivative Melt to view the Derivative Melt Plot.
2. Select Target » <assay> to view the melt data for the desired assay.

3. In the Derivative Melt plot, set the pre-melt region:

a. Click and drag the Pre-melt Stop temperature line (red arrow on the left)
adjacent to the start of the melt transition region.

b. Click and drag the Pre-melt Start temperature line (green arrow on the left)
approximately 0.2°C to 0.5°C from the Pre-melt Stop temperature line.

Note: The Pre-melt region should be within a flat area where there are no large
spikes or slopes present in the fluorescence levels.

4. Set the post-melt region:

a. Click and drag the Post-melt Start temperature line (black arrow on the
right) adjacent to the end of the melt transition region.

b. Click and drag the Post-melt Stop temperature line (yellow arrow on the

right) approximately 0.2°C to 0.5°C from the Post-melt Start temperature
line.
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Note: The Post-melt region should be within a flat area where there are no large
spikes or slopes present in the fluorescent levels.

Click Analyze.

The software reanalyzes the data using the new Pre- and Post-melt regions. The
colors of the melt curves change to reflect the new results.

The Applied Biosystems  qPCR Analysis Software calls each sample according to the
shape of the aligned melt curves and the Tm. Review the software calls, then omit

outliers or change calls.

1.

™

In the Applied Biosystems™ qPCR Analysis Software, select the Quality Control
& Results tab.

In the Quality Control & Results pane, select Plot » Difference to review the
Difference Melt Curve Plot.

From the View By drop-down list, select Well Table to review the genotyping
calls generated by the software.

In the well table, click the Well column header to sort the results according to the
well position.

For the positive controls, review:

* Variant Call column - Do all of the positive control replicates have the
correct call?

* Cq Confidence column — Are there any outliers within the replicate group?
Do the values for the replicate group differ greatly from the confidence
values for other replicate groups in the plate?

Note: If any of the controls are outliers, omit them from the HRM analysis, then
reanalyze.

For each replicate group, review:
* Variant Call column - Do all replicates have the same call?

¢ (Cq Confidence column — Are there any outliers within the replicate group?
Do the values for the replicate group differ greatly from the confidence
values for other replicate groups in the plate?

Select the rows in the Results table to view the corresponding fluorescence data
in the Difference Melt Plot.

In the Results pane, click the Variant column header to sort the results according

to the variant call. For each variant call, review the samples that are assigned that
call.
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Review the The Multicomponent Plot displays the complete spectral contribution of each dye in a
Multicomponent selected well over the duration of the PCR run.
plot Review the Multicomponent Plot for:

MeltDoctor  HRM dye or your custom reporter dye
Spikes, dips, and/or sudden changes

Amplification in the negative control wells

. In the Applied Biosystems™ qPCR Analysis Software, select the Quality Control

& Results tab.

In the Quality Control & Results tab, select all wells in the plate grid.
Select Plot » Multicomponent to view the Multicomponent Plot.
Select Target » <assay>to view the data for the desired assay.

Select one unknown well in the plate layout to display the corresponding data in
the Multicomponent Plot.

Note: If you select multiple wells, the Multicomponent Plot screen displays the

data for all selected wells simultaneously.

Click -@ (View Options), then select Color By » Dye.
If the Legend is not displayed, also select Show Legend.

Confirm that the dye signals in the Multicomponent Plot increase throughout the
PCR, indicating normal amplification.

In the Well Table or Plate Grid, select all negative control wells, then confirm that
they did not amplify. If amplification has taken place, the negative controls may
be contaminated.

When reviewing the Multicomponent Plot, look for:

Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

Any irregularities in the signal — There should not be any spikes, dips, and/or
sudden changes in the fluorescent signal.

Negative control wells — There should not be any amplification in the negative
control wells.
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Review the If you collected real-time data for your experiment, review the amplification data to

Amplification Plot further understand the flags triggered by the experiment data. The Amplification Plot
screen displays amplification of all samples in the selected wells. Use the
amplification plots to confirm the results of the experiment:

ARn vs Cycle — This plot displays ARn as a function of cycle number. You can use
this plot to identify and examine irregular amplification and to view threshold
and baseline values for the run.

Rn vs Cycle - This plot displays Rn as a function of cycle number. You can use
this plot to identify and examine irregular amplification.

Cr vs Well - This plot displays Cr as a function of well position. You can use this
plot to locate outlying amplification (outliers)

Each amplification plot can be viewed as a linear or log10 graph.

1.

™

In the Applied Biosystems™ qPCR Analysis Software, select the Quality Control
& Results tab.

In the Quality Control & Results tab, select all wells in the plate grid.
Select Plot » Amplification to view the Multicomponent Plot.
Select Target » <assay>to view the data for the desired assay.

In the Amplification Plot, click @ (View Options), then select:
¢ Plot Type » ARn vs Cycle
e Color By » Sample
* Graph Type » Log

If the Legend is not displayed, also select Show Legend.
Verify that the threshold is set correctly.
Repeat above steps for all targets.

In the Amplification Plot, click = (View Options), then select:
* Plot Type » Ct vs Well
¢ Color By » Sample

Confirm that the populations of technical replicates have achieved similar
amplification.

When you analyze the Amplification Plot, look for:

44

Outliers

A typical amplification plot — The Applied Biosystems  qPCR Analysis Software
calculates baseline and threshold values based on the assumption that the data
exhibit a typical amplification plot. A typical amplification plot has four distinct
sections:

— Plateau phase
— Linear phase
— Exponential (geometric phase)

— Baseline
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Perform manual Perform manual calls when you want to manually assign a sample to a variant group.

calls 1. In the Applied Biosystems™ qPCR Analysis Software, select the Quality Control

& Results tab.
2. In the Quality Control & Results pane, select the experiment of interest.

3. In the Review Result screen, select one or more wells within a Melt Curve Plot,
Plate Layout, or Well Table.

4. Click Actions, then select Manual Call.

5. From the Manual Call dialog box, you can assign the sample to:

* An existing variant call - Click Select Existing, select the appropriate call
from the Group drop-down menu, then click OK.

e A new variant call - Click Create New, enter a name for the new call in the
Group field, select a color, then click OK.

In the Plate Layout tab, the upper right corner of the sample well is marked with
a red triangle.

In the Well Table tab, in the Method column, Manual appears next to the selected
sample.

6. Repeat the steps above to assign more manual calls.

7. Click Analyze to reanalyze the data using the manual calls.

Omit wells from To omit the data from one or more wells that you do not want included in the
the analysis analysis:

* Select one or more wells in a plot or table, then click Actions » Omit. After the
wells are omitted, click Analyze to reanalyze the project without the omitted
well(s).
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The following workflow illustrates the general steps required to perform a high-

resolution melt curve mutation detection experiment using MeltDoctor™ HRM
Reagents on an Applied Biosystems'™ Real- Time PCR System followed by analysis
using the Applied Biosystems™ qPCR Analysis Software.
Calibrate your instrument
v

Design your HRM experiment
v

Perform the experiment
v

Analyze the data
Create a project and add experiment data
v
(Optional) Add and define samples and targets
v
Review/edit the sample, target, task, and control assignments
v
Review the results of the analysis and adjust the settings (if necessary)
v
Publish the project data
v

Sequence the variants
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Configure your analysis project

Log into the
Thermo Fisher
Cloud

Create a project
and add
experiment data

After you create your HRM project using the Thermo Fisher Cloud and populate it
with experiments, use the Applied Biosystems™ qPCR Analysis Software HRM
Module to correct any experiment settings prior to the analysis.

Note: As an alternative to using the Thermo Fisher Cloud or the Applied
Biosystems™ HRM Analysis Module as described in this guide, you can use the
Applied Biosystems ™ High Resolution Melt Software v3.1 (Cat. No. A29881) to
analyze your HRM experiments. The High Resolution Melt Software is a Windows"'-
compatible desktop application that performs high resolution melt (HRM) analysis of
experiments generated by Applied Biosystems™ Real-Time PCR Systems, including
the QuantStudio™ 3 and 5 Real-Time PCR Systems.

Analysis of the HRM experiment data is performed using the Applied Biosystems
qPCR Analysis Software HRM Module, which is available on the Thermo Fisher
Cloud. The Thermo Fisher Cloud is a cloud storage and applications environment that
provides scientists with a secure location to store, analyze, and share data. If
connected to the internet, you can upload your HRM experiment data directly from
your Applied Biosystems QuantStudio 3 or 5 Real-Time PCR Instrument or upload
the experiment files from anywhere you have web access.

Note: For more information on the Thermo Fisher Cloud, go to https://
www.thermofisher.com/cloud.

To log into the Thermo Fisher Cloud:

* Using an internet browser, go to https://apps.thermofisher.com , then log into the
Thermo Fisher Cloud using your user account and password.

If you do not have a Thermo Fisher Cloud user account, click Create an account,
then follow the on-screen instructions to create an account for your projects. The
Applied Biosystems™ qPCR Analysis Software HRM Module is available from
within the Thermo Fisher Cloud.

1. Click /& (Manage Projects) to view the Dashboard.

2. Create the project:
a. Click [ New Project.

b. In the Create Project dialog box, enter a name for the project, select the
folder within which you want to place the project, then click OK.

Note: The project name cannot exceed 50 characters and cannot include any
of the following characters: / \ <>*?" | :; & % $@" ()!
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Manage samples
and targets
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3. From the Manage Data screen, add any additional experiment data to the project.

To import
experiment data
stored on...

Action

Your computer

1. Click Import from local.

. Click Close prompted that the import is complete.

From the Open dialog box, select one or more experiment
files (.sds or .eds], then click Open.

Note: Ctrl- or Shift-click to select multiple files.

Wait for the Applied Biosystems" Software to upload the
selected data.

Thermo Fisher
Cloud

1. Click Import from Thermo Fisher Cloud.
. Select one or more experiment files (.sds or .eds) from

. When you are done adding files to the queue, click OK.
. Click Close prompted that the import is complete.

the table, then click Add.

4. Repeat step 3 until your project contains all of the desired experiment data.

5. Click the appropriate analysis module on the left side of the screen to begin the

analysis.

The Applied Biosystems  qPCR Analysis Software populates the Overview screen
with the samples and targets present in the experiments added to the project. If
necessary, you can add, edit, or remove the samples and targets as needed before the

analysis.

¢ Create a new sample or target:

a. From the Samples or Targets table in the Overview screen,

click Actions » Add.

b. In the New Sample/Target dialog box, enter a name for the new sample or
target (up to 256 characters), then edit the properties of the new

sample/target.

c. Click OK.

¢ Update an existing sample or target by editing the entry directly in the table.

Note: Alternately, select a sample or target from the table, then

select Actions » Update.

* Delete a sample or target:

a. From the Samples or Targets table in the Overview screen, select the sample
or target of interest, then click Actions » Delete.

b. In the confirmation dialog box, click OK to delete the sample or target.
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Manage HRM The Applied Biosystems  qPCR Analysis Software populates the Overview screen
controls with the controls present in the experiments added to the project.

If necessary, you can add, edit, or remove controls as needed before the analysis:

¢ Create a new control:

a. From the Controls table in the Overview screen, click Actions » Add.

b. In the New Control dialog box, enter a name for the new control (up to 256
characters), then edit the properties of the new control.

c. Click OK.

¢ Update an existing control by editing the entry directly in the table.

Note: Alternately, select a control from the table, then select Actions » Update.

¢ Delete a control:

a. From the Controls table in the Overview screen, select the control of interest,
then click Actions » Delete.

b. In the confirmation dialog box, click OK to delete the control.

Review and edit After configuring your project with all necessary samples and targets, use the Plate

the plate setups Setup screen to review the experiments for problems that can prevent the analysis of
the project. The Applied Biosystems qPCR Analysis Software displays plate
configuration errors that can prohibit analysis in the margin beneath each image of
the related experiment. Before you can analyze your project, you must use the Plate
Setup screen to address them.

To review the plate setup information for your project:

1. Select Plate Setup to display Plate Setup screen.
2. From the Plate Setup screen, review the experiment records for errors.

3. If errors are present, click the experiment record of interest and address the
problem that is preventing the analysis of the file.

Note: The software displays plate configuration problems that will prevent
analysis of an experiment beneath the image of the related plate.
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Apply samples and targets

If the sample or target assignments of one or more of your experiments contain errors
or are missing, you can use the Applied Biosystems = qPCR Analysis Software to
correct the problem prior to analysis.

Note: When reviewing a plate layout, click Actions » Clear Well Setup to remove the
well information (sample, task, and target assignments) from the selected wells in the
plate grid.

1. From the Plate Setup screen, select the experiment that you want to modify.

2. (Optional) From the Edit Plate screen, click View <@, then select Target and
Sample to color the plate setup according to the element that you intend to
modify.

3. Select the wells of the plate layout to which you want to apply the target or
sample.

4. When the wells are selected, click the appropriate field to the right of the plate
grid, then select the appropriate item from the list.

Note: If you have not yet created a sample or target, enter the name in the
appropriate field and press Enter to create the new sample or target.

5. Once you are finished making changes to the plate layout, click Analyze to
reanalyze your project.

Specify and assign tasks

If the task assignments of one or more of your experiments contain errors or are
missing, you can use the Applied Biosystems qPCR Analysis Software to correct the
problem prior to analysis.

Note: When reviewing a plate layout, click Actions » Clear Well Setup to remove the
well information (sample, task, and target assignments) from the selected wells in the
plate grid.

1. From the Plate Setup screen, select the experiment record that you want to
modify.

2. From the Edit Plate screen, click View -@, then select Task to color the plate
setup according to task assignment.

3. Select the wells of the plate layout to which you want to apply a task.
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4. When the wells are selected, click the Task menu, then select the appropriate task
from the list.

Available tasks include:

¢ Unknown - The task for wells that contain a sample with unknown
genotype, variant content, or percentage methylation.

* NTC - The task for wells that contain water or buffer instead of sample (no
template controls). No amplification of the target should occur in negative
control wells.

* Positive Controls - Wells that contain one of the following;:
— A template known to generate a specific genotype call for one or both
alleles (Heterozygote or Homozygote).
- A wild type control (Wild Type).

— Methylated DNA standards that contain from 0% to 100% methylated
DNA (add a custom control label).

Note: The Task/Control dropdown list displays the controls present in the
Controls pane of the Overview screen. See “Manage HRM controls” on
page 34 for information on adding and editing controls.

5. Repeat steps 3 and 4 as needed.

6. Once you have completed making changes to the plate layout, click Analyze to
reanalyze your project.

Review HRM mutation detection data

The Applied Biosystems™ qPCR Analysis Software High Resolution Melt module
supports the analysis of HRM mutation detection experiments, where melt curve
technique is used to screen DNA samples for new single-base changes,
insertions/deletions, or other unknown mutations. During the analysis, the software
compares the melt curves of unknown samples to those generated from one or more
DNA samples that contain wild type sequences (positive controls). Based on the
comparison, the software assigns calls to the unknown samples according to the fit of
the unknown melt curves to those of the controls. For the unknowns, possible calls are
either “wild type” if the sample matches a control or “variant X” if the sample does
not.

In general, review of genotyping results occurs in the following steps:

1. Define the analysis settings, then analyze the project.

2. Perform an initial review of the High Resolution Melt Plots, the Plate Layout, and
the Well Table to evaluate the calls made by the Applied Biosystems™ Software.

3. Perform a thorough review of the QC Summary to evaluate the samples that
triggered QC flags. Review the raw data and amplification data for the samples
that exhibit abnormal amplification.

4. If necessary, adjust the analysis settings or modify the calls manually.

After evaluating the results, publish the analyzed data.
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Configure the When a project is created, the Applied Biosystems  qPCR Analysis Software

analysis settings processes the project data using the default analysis settings of the experiments added
to the project. If desired, you can modify the analysis settings from the Quality
Control & Results screen (for example, manual versus automatic thresholding or
stringent versus relaxed quality thresholds).

1. From the Quality Control & Results screen, select an experiment of interest.
2. From the Review Result screen, click Analysis Settings.

3. From the Edit Analysis Setting dialog box, modify the analysis settings as
desired.

Group Settings

Target Settings Select the method (automatic or manual) that the Applied Biosystems™ Software will use to
compute the pre- and post-melt ranges, grouping, and variant removal:

¢ Define whether the pre- and post-melt range for each target will be computed
automatically or manually:
- Auto Set Melt Range - If you are using automatic settings, select the checkbox to
have the software calculate the pre- and post- melt ranges for the specific target.

- Pre-Melt Start/Stop and Post-Melt Start/Stop - If you are using manual settings,

enter the manual pre- and post-range values for the appropriate targets.
¢ Define whether the genotype groups for each target will be determined automatically or
manually:

- Auto Determine # of Groups - If you are using automatic settings, select the
checkbox to have the software calculate the number of groups for the specific
target.

- Number of Groups - If you are using manual settings, enter the number of groups
for the appropriate targets.

¢ Remove all Manual Variants on reanalysis - Select to have the software omit from the
analysis all wells that have been manually been labeled as a variant.

Flag Settings Specify the quality measures that the Applied Biosystems" Software will compute during the
analysis.
1. In the Use column, select the check boxes for flags you want to apply during analysis.
2. If an attribute, condition, and value are listed for a flag, you can specify the setting for
applying the flag.
For example, with the default setting for the no amplification flag (NOAMP), wells are
flagged if the amplification algorithm result is less than 0.1.

Note: If you choose to adjust the setting for applying a flag, make minor adjustments as
you evaluate the appropriate setting.

3. Inthe Reject Well column, select the check boxes if you want the software to reject
wells with the flag. Rejected wells are not considered for data analysis.

4. When done modifying the analysis settings, click Finish.
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Review the quality  After the Applied Biosystems qPCR Analysis Software processes your project, you

data can use the Quality Control & Results screen to review the quality data generated by
the analysis. The software provides a variety of options to review the quality data;
however, the strategy that you employ will depend on the type of experiment you are
performing and the samples/targets that you are evaluating. The following procedure
describes a general approach to data review and provides an overview of the software
features.

1. If you have not already done so, click Analyze to analyze your project.
2. Click Quality Control & Results to view the Quality Control & Results screen.

3. Review the experiment data for quality flags generated during the analysis.

™

Note: The Applied Biosystems™ Software displays summaries of the quality
data in the margin beneath each experiment. You can view the identity of the
triggered flags by mousing over an experiment of interest.

Alternatively, to quickly find the experiments in your project that generated
quality flags, click = (Plate View), then click the Flags column heading to sort
the experiments that generated quality flags to the top of the table. To examine
the data that triggered the flag, click the corresponding link in the Name column.

In response to the presence of quality flags, consider the following resolutions:

* Change the quality settings in the analysis settings:

— Adjust the sensitivity of the quality flags so that more wells or fewer
wells are flagged.

— Deactivate the quality flags that triggered by the data.

* Omit individual wells from the analysis.

4. If flags or irregularities are present, or you would like to review the melt curve
data for a specific experiment, click the experiment of interest.

5. When viewing an experiment, display the Well Table:

Tool Use this tool to...

Select wells. To select:
e Anindividual well, select the well in the Well table.

e More than one well at a time, press the Ctrl key or Shift key

Mouse/cursor when you select the wells in the Well table.

When you select wells in the Well table, the corresponding data
points are selected in the amplification plot.

Omit/Un-Omit well from the analysis.
After you omit or un-omit a well, click Analyze to reanalyze the
project.

Actions menu For omitted wells, the software:

* Does not display data in the Well table (data are either
Unknown or empty/blank].

¢ Does not include the omitted wells in the analysis.

Expand or collapse the Well table by clicking the appropriate

forp symbol in the vertical bar between the plot and table.
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6. Review the data in the Well Table data.

Column Description
The location of the well on the reaction plate. For example, P18 indicates that the sample is
Well )
found in row P, column 18.
Omit The omission status of the related well.
The ID (a unique name or number) of the nucleic acid sequence targeted by the assay added
Target
to the well.
Sample The ID (a unique name or number) of the sample.
Task/Control The task assigned to the well, where the task is the function that a sample performs on the
plate.
Variant The call for the sample in well. Can be assigned by software (Auto) or manually.
Method The method used to apply the call to the well: Auto(matic) if calculated by the Applied

Biosystems" qPCR Analysis Software or Manual if user-applied.

Silhouette Score

The modified silhouette score calculated for the well, which measures distinguishably of the
associated melt curve relative to the other curves in the assay (Rousseeuw, 1987.).

For each melt curve, the software calculates a modified silhouette score, which ranges from
0 to 100. A score closer to 100 indicates that a melt curve is more similar to curves assigned
the same variant call than to curves called differently. Lower silhouette scores indicate that a
melt curve is less similar to curves assigned the same variant call.

IMPORTANT! The modified silhouette score differs from the standard silhouette score
(Lovmar, et. al., 2005.) in that the software assigns the score to each identified cluster

instead of to each data point in the cluster. In addition, the modified value ranges from 0 to
100.

The 1st, 2nd, and 3rd calculated melt temperature (Tm) for the well (if present).

Tm1/Tm2/Tm3 Note: Blank table cells indicate that the software calculated no Tm for the well at the
indicated position.
The amplification status for the well: amplification, no amplification, reviewed, and
Amp Status .
undetermined.
Amp Score The amplification score calculated for the well.
Cq Conf The Cq confidence score calculated for the well.
Ct The Ct calculated for the related well.
Ct Mean The arithmetic mean generated from the Cys calculated for the technical replicates of the
well.
CctSD The standard deviation generated from the Cts calculated for the technical replicates of the
well.
Flags The number of flags generated for the well.
Quality data The quality flags generated by the associated well.
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7. When ready, click € to return to the thumbnails view.
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Review the The Aligned Melt Curves plot displays the melt curves as percentage melt (0 - 100%)

controls and over temperature. The melt curves are aligned to the same fluorescence level using the

replicate pre- and post-melt regions that you set.

populations for 1. Display the Aligned Melt Plot for the experiment of interest:

outliers a. In the Applied Biosystems™ qPCR Analysis Software, select the Quality
Control & Results tab.

b. In the Quality Control & Results tab, select an experiment of interest, then
select all wells in the plate grid.

c. Select Plot » Aligned Melt to view the Aligned Melt plot.

2. If using Wild type controls, confirm the calls for the positive controls:

a. From the well table, select the wells containing a positive control to
highlight the corresponding melt curve in the Aligned Melt Curves Plot.

b. Confirm that the wild type controls cluster well and review the population
for outliers.

c. Repeat steps a and b for the wells containing the other positive controls.

3. Screen the negative controls to ensure that samples failed to amplify:

a. From the well table, select the wells containing a negative control to
highlight the corresponding melt curve in the Aligned Melt Curves Plot.

b. Confirm that the selected wells in the well table are negative controls, and
not unknown samples.

Samples that grouped with the negative controls may:
¢ Contain no DNA
* Contain PCR inhibitors

* Be homozygous for a sequence deletion

4. If you run replicate reactions, carefully review your data set for curves that do
not align tightly with the other samples in the group (outliers). If outliers are
present, confirm the results of the associated samples by retesting them.

5. Review the data:

* Possible mutations — Review the curves for samples with melt curves that
are different from the wild type melt curves.

* Unexpected peaks — Confirm that the Derivative Melt Curve shows no
unexpected Tm peaks. If the sequence you amplified contains more than one
variant or a more complex mutation, you may see more than one Tm peak.
Unexpected peaks can indicate contamination, primer dimers, or non-
specific amplification.
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Review and adjust When you analyze an HRM experiment, the software calculates the Pre- and Post-melt

the pre- and post- regions using default settings. You can review and adjust the Pre- and Post-melt

melt regions regions to optimize your separation and variant calls. For most experiments, set the
Pre- and Post-melt regions as close as possible to the melt transition region.

About the pre- and post-melt regions

In the Derivative Melt Curves plot and the Raw Melt Curves plot, there are two pairs
of vertical lines before and after the data peak. These lines define the pre- and post-
melt regions used to scale the data in the Aligned Melt Curves and Difference Plot.

* Pre-melt region — The pair of lines to the left of the peak indicate the pre-melt
Start and Stop temperatures when every amplicon is double-stranded.

Fluorescence data from the pre-melt region corresponds to 100% fluorescence in
the Aligned Melt Curves Plot.

* Active melt region — The data peak indicates the active melt region of the plot.
Data from the active melt region are used to plot the Aligned Melt Curves Plot.

* Post-melt region — The set of lines to the right of the peak indicate the post-melt
Start and Stop temperatures when every amplicon is single-stranded.
Fluorescence data from the post-melt region correspond to 0% fluorescence in the
Aligned Melt Curves Plot.

Review and adjust the pre- and post-melt regions

1. Display the Derivative Plot for the experiment of interest:

™

a. Inthe Applied Biosystems™ qPCR Analysis Software, select the Quality
Control & Results tab.

b. In the Quality Control & Results tab, select an experiment of interest, then
select all wells in the plate grid.

c. Select Plot » Derivative Melt to view the Derivative Melt Plot.
2. Select Target » <assay> to view the melt data for the desired assay.

3. In the Derivative Melt plot, set the pre-melt region:

a. Click and drag the Pre-melt Stop temperature line (red arrow on the left)
adjacent to the start of the melt transition region.

b. Click and drag the Pre-melt Start temperature line (green arrow on the left)
approximately 0.2°C to 0.5°C from the Pre-melt Stop temperature line.

Note: The Pre-melt region should be within a flat area where there are no large
spikes or slopes present in the fluorescence levels.

4. Set the post-melt region:

a. Click and drag the Post-melt Start temperature line (black arrow on the
right) adjacent to the end of the melt transition region.

b. Click and drag the Post-melt Stop temperature line (yellow arrow on the

right) approximately 0.2°C to 0.5°C from the Post-melt Start temperature
line.
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Note: The Post-melt region should be within a flat area where there are no large
spikes or slopes present in the fluorescent levels.

5. Click Analyze.

The software reanalyzes the data using the new Pre- and Post-melt regions. The
colors of the melt curves change to reflect the new results.

Review the The Aligned Melt Curves plot displays the melt curves as percentage melt (0-100%)
populations in the over temperature. The melt curves are aligned to the same fluorescence level using the

Aligned Melt Plot pre- and post-melt regions that you set.

1. Display the Aligned Melt Plot for the experiment of interest:

a. In the Applied Biosystems™ qPCR Analysis Software, select the Quality
Control & Results tab.

b. In the Quality Control & Results tab, select an experiment of interest, then
select all wells in the plate grid.

c. Select Plot » Aligned Melt to view the Aligned Melt plot.

2. Review:

* Wild type controls — Do the melt curves for the wild type controls cluster
well? Are there any outliers?

* Possible mutations — Are there any samples with melt curves that are
different from the wild type melt curves?

3. Repeat the steps for the remaining experiments in your project.

Review the The Difference Plot displays the aligned data as the difference in fluorescence between
Difference Melt the melt curve for a reference sample and the other melt curves. You can select a
control or any well as a reference. After you select the reference, the software

Curves Plot for subtracts the reference curve from the other curves.

outliers
The Difference Plot allows you to more easily see small differences between curves

and identify outliers.

1. Display the Difference Plot for the experiment of interest:

™

a. Inthe Applied Biosystems™ qPCR Analysis Software, select the Quality
Control & Results tab.

b. In the Quality Control & Results tab, select an experiment of interest, then
select all wells in the plate grid.

c. Select Plot » Difference Melt to view the Difference Melt Plot.

2. From the Reference drop-down menu, select a control or any well as the
reference, then review:

* Variant clusters - How many distinct clusters are displayed?

* Outliers - How tight are the curves within each variant cluster?

Note: Try selecting different reference samples to find the optimal display of the
clusters.
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Confirm the The Applied Biosystems  qPCR Analysis Software calls each sample according to the
software calls shape of the aligned melt curves and the Tm. Review the software calls, then omit
outliers or change calls.

1.

Display the Aligned Plot for the experiment of interest:

a. In the Applied Biosystems™ qPCR Analysis Software, select the Quality
Control & Results tab.

b. In the Quality Control & Results tab, select an experiment of interest, then
select all wells in the plate grid.

c. Select Plot » Aligned Melt to view the Aligned Melt Plot.

In the Well Table, select Well Table from the View By drop-down list to review
the calls generated by the software.

In the well table, click the Well column header to sort the results according to the
well position.

For each replicate group, review:
* Variant Call column - Do all replicates have the same call?

* Confidence column — Are there any outliers within the replicate group? Do
the values for the replicate group differ greatly from the confidence values
for other replicate groups in the plate?

Select the rows in the Results table to view the corresponding fluorescence data
in the Aligned Melt Plot.

In the well table, click the Variant column header to sort the results according to
the variant call. Scan the results for samples that were not assigned the same call
as the wild type control.

Perform manual Perform manual calls when you want to manually assign a sample to a variant group.

calls 1
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™

. In the Applied Biosystems™ qPCR Analysis Software, select the Quality Control

& Results tab.
In the Quality Control & Results pane, select the experiment of interest.

In the Review Result screen, select one or more wells within a Melt Curve Plot,
Plate Layout, or Well Table.

Click Actions, then select Manual Call.
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5. From the Manual Call dialog box, you can assign the sample to:

* An existing variant call - Click Select Existing, select the appropriate call
from the Group drop-down menu, then click OK.

¢ A new variant call - Click Create New, enter a name for the new call in the
Group field, select a color, then click OK.

In the Plate Layout tab, the upper right corner of the sample well is marked with
a red triangle.

In the Well Table tab, in the Method column, Manual appears next to the selected
sample.

6. Repeat the steps above to assign more manual calls.

7. Click Analyze to reanalyze the data using the manual calls.

Omit wells from To omit the data from one or more wells that you do not want included in the
the analysis analysis:

* Select one or more wells in a plot or table, then click Actions » Omit. After the
wells are omitted, click Analyze to reanalyze the project without the omitted
well(s).

(Optional) Sequence the variants

After you identify the variants in the HRM software, dilute or purify the PCR product
from the HRM reactions, then sequence the variants. For more information on
sequencing the variants, contact Thermo Fisher Scientific.
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HRM methylation study analysis workflow

The following workflow illustrates the general steps required to perform a high-

™

resolution melt curve methylation experiment using MeltDoctor™ HRM Reagents on

an Applied Biosystems™ Real- Time PCR System followed by analysis using the
Applied Biosystems™ qPCR Analysis Software.
Calibrate your instrument
v

Design your HRM experiment
v

Perform the experiment
v

Analyze the data
Create a project and add experiment data
v
(Optional) Add and define samples and targets
v
Review/edit the sample, target, task, and control assignments
v
Review the results of the analysis and adjust the settings (if necessary)
v
Publish the project data
v

Sequence the variants
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Configure your analysis project

Log into the
Thermo Fisher
Cloud

Create a project
and add
experiment data

After you create your HRM project using the Thermo Fisher Cloud and populate it
with experiments, use the Applied Biosystems™ qPCR Analysis Software HRM
Module to correct any experiment settings prior to the analysis.

Note: As an alternative to using the Thermo Fisher Cloud or the Applied
Biosystems™ HRM Analysis Module as described in this guide, you can use the
Applied Biosystems ™ High Resolution Melt Software v3.1 (Cat. No. A29881) to
analyze your HRM experiments. The High Resolution Melt Software is a Windows"'-
compatible desktop application that performs high resolution melt (HRM) analysis of
experiments generated by Applied Biosystems™ Real-Time PCR Systems, including
the QuantStudio™ 3 and 5 Real-Time PCR Systems.

Analysis of the HRM experiment data is performed using the Applied Biosystems
qPCR Analysis Software HRM Module, which is available on the Thermo Fisher
Cloud. The Thermo Fisher Cloud is a cloud storage and applications environment that
provides scientists with a secure location to store, analyze, and share data. If
connected to the internet, you can upload your HRM experiment data directly from
your Applied Biosystems QuantStudio 3 or 5 Real-Time PCR Instrument or upload
the experiment files from anywhere you have web access.

Note: For more information on the Thermo Fisher Cloud, go to https://
www.thermofisher.com/cloud.

To log into the Thermo Fisher Cloud:

* Using an internet browser, go to https://apps.thermofisher.com , then log into the
Thermo Fisher Cloud using your user account and password.

If you do not have a Thermo Fisher Cloud user account, click Create an account,
then follow the on-screen instructions to create an account for your projects. The
Applied Biosystems™ qPCR Analysis Software HRM Module is available from
within the Thermo Fisher Cloud.

1. Click /& (Manage Projects) to view the Dashboard.

2. Create the project:
a. Click [ New Project.

b. In the Create Project dialog box, enter a name for the project, select the
folder within which you want to place the project, then click OK.

Note: The project name cannot exceed 50 characters and cannot include any
of the following characters: / \ <>*?" | :; & % $@" ()!
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Manage samples
and targets
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3. From the Manage Data screen, add any additional experiment data to the project.

To import
experiment data
stored on...

Action

Your computer

1. Click Import from local.

. Click Close prompted that the import is complete.

From the Open dialog box, select one or more experiment
files (.sds or .eds], then click Open.

Note: Ctrl- or Shift-click to select multiple files.

Wait for the Applied Biosystems" Software to upload the
selected data.

Thermo Fisher
Cloud

1. Click Import from Thermo Fisher Cloud.
. Select one or more experiment files (.sds or .eds) from

. When you are done adding files to the queue, click OK.
. Click Close prompted that the import is complete.

the table, then click Add.

4. Repeat step 3 until your project contains all of the desired experiment data.

5. Click the appropriate analysis module on the left side of the screen to begin the

analysis.

The Applied Biosystems  qPCR Analysis Software populates the Overview screen
with the samples and targets present in the experiments added to the project. If
necessary, you can add, edit, or remove the samples and targets as needed before the

analysis.

¢ Create a new sample or target:

a. From the Samples or Targets table in the Overview screen,

click Actions » Add.

b. In the New Sample/Target dialog box, enter a name for the new sample or
target (up to 256 characters), then edit the properties of the new

sample/target.

c. Click OK.

¢ Update an existing sample or target by editing the entry directly in the table.

Note: Alternately, select a sample or target from the table, then

select Actions » Update.

* Delete a sample or target:

a. From the Samples or Targets table in the Overview screen, select the sample
or target of interest, then click Actions » Delete.

b. In the confirmation dialog box, click OK to delete the sample or target.
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Manage HRM The Applied Biosystems  qPCR Analysis Software populates the Overview screen
controls with the controls present in the experiments added to the project.

If necessary, you can add, edit, or remove controls as needed before the analysis:

¢ Create a new control:

a. From the Controls table in the Overview screen, click Actions » Add.

b. In the New Control dialog box, enter a name for the new control (up to 256
characters), then edit the properties of the new control.

c. Click OK.

¢ Update an existing control by editing the entry directly in the table.

Note: Alternately, select a control from the table, then select Actions » Update.

¢ Delete a control:

a. From the Controls table in the Overview screen, select the control of interest,
then click Actions » Delete.

b. In the confirmation dialog box, click OK to delete the control.

Review and edit After configuring your project with all necessary samples and targets, use the Plate

the plate setups Setup screen to review the experiments for problems that can prevent the analysis of
the project. The Applied Biosystems qPCR Analysis Software displays plate
configuration errors that can prohibit analysis in the margin beneath each image of
the related experiment. Before you can analyze your project, you must use the Plate
Setup screen to address them.

To review the plate setup information for your project:

1. Select Plate Setup to display Plate Setup screen.
2. From the Plate Setup screen, review the experiment records for errors.

3. If errors are present, click the experiment record of interest and address the
problem that is preventing the analysis of the file.

Note: The software displays plate configuration problems that will prevent
analysis of an experiment beneath the image of the related plate.
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Apply samples and targets

If the sample or target assignments of one or more of your experiments contain errors
or are missing, you can use the Applied Biosystems = qPCR Analysis Software to
correct the problem prior to analysis.

Note: When reviewing a plate layout, click Actions » Clear Well Setup to remove the
well information (sample, task, and target assignments) from the selected wells in the
plate grid.

1. From the Plate Setup screen, select the experiment that you want to modify.

2. (Optional) From the Edit Plate screen, click View <@, then select Target and
Sample to color the plate setup according to the element that you intend to
modify.

3. Select the wells of the plate layout to which you want to apply the target or
sample.

4. When the wells are selected, click the appropriate field to the right of the plate
grid, then select the appropriate item from the list.

Note: If you have not yet created a sample or target, enter the name in the
appropriate field and press Enter to create the new sample or target.

5. Once you are finished making changes to the plate layout, click Analyze to
reanalyze your project.

Specify and assign tasks

If the task assignments of one or more of your experiments contain errors or are
missing, you can use the Applied Biosystems qPCR Analysis Software to correct the
problem prior to analysis.

Note: When reviewing a plate layout, click Actions » Clear Well Setup to remove the
well information (sample, task, and target assignments) from the selected wells in the
plate grid.

1. From the Plate Setup screen, select the experiment record that you want to
modify.

2. From the Edit Plate screen, click View -@, then select Task to color the plate
setup according to task assignment.

3. Select the wells of the plate layout to which you want to apply a task.
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4. When the wells are selected, click the Task menu, then select the appropriate task
from the list.

Available tasks include:
¢ Unknown - The task for wells that contain a sample with unknown
genotype, variant content, or percentage methylation.

* NTC - The task for wells that contain water or buffer instead of sample (no
template controls). No amplification of the target should occur in negative
control wells.

* Positive Controls - Wells that contain one of the following;:

— A template known to generate a specific genotype call for one or both
alleles (Heterozygote or Homozygote).

- A wild type control (Wild Type).
— Methylated DNA standards that contain from 0% to 100% methylated
DNA (add a custom control label).

Note: The Task/Control dropdown list displays the controls present in the
Controls pane of the Overview screen. See “Manage HRM controls” on
page 34 for information on adding and editing controls.

5. Repeat steps 3 and 4 as needed.

6. Once you have completed making changes to the plate layout, click Analyze to
reanalyze your project.

Review HRM methylation data

The Applied Biosystems™ qPCR Analysis Software High Resolution Melt module
supports the analysis of HRM methylation experiments, where melt curve technique
is used to determine the percentage of methylated DNA in unknown samples. During
the analysis, the software compares the melt curves of the unknown samples against
those generated from a set of methylated DNA standards (positive controls). Based on
the comparison, the software assigns calls to the unknown samples according to the fit
of the unknown melt curves to those of the standard ladder.

In general, review of HRM methylation results occurs in the following steps:

1. Define the analysis settings, then analyze the project.

2. Perform an initial review of the High Resolution Melt Plots, the Plate Layout, and
the Well Table to evaluate the calls made by the Applied Biosystems™ Software.

3. Perform a thorough review of the QC Summary to evaluate the samples that
triggered QC flags. Review the raw data and amplification data for the samples
that exhibit abnormal amplification.

4. If necessary, adjust the analysis settings or modify the calls manually.

After evaluating the results, publish the analyzed data.
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Configure the When a project is created, the Applied Biosystems  qPCR Analysis Software

analysis settings processes the project data using the default analysis settings of the experiments added
to the project. If desired, you can modify the analysis settings from the Quality
Control & Results screen (for example, manual versus automatic thresholding or
stringent versus relaxed quality thresholds).

1. From the Quality Control & Results screen, select an experiment of interest.
2. From the Review Result screen, click Analysis Settings.

3. From the Edit Analysis Setting dialog box, modify the analysis settings as
desired.

Group Settings

Target Settings Select the method (automatic or manual) that the Applied Biosystems™ Software will use to
compute the pre- and post-melt ranges, grouping, and variant removal:

¢ Define whether the pre- and post-melt range for each target will be computed
automatically or manually:
- Auto Set Melt Range - If you are using automatic settings, select the checkbox to
have the software calculate the pre- and post- melt ranges for the specific target.

- Pre-Melt Start/Stop and Post-Melt Start/Stop - If you are using manual settings,

enter the manual pre- and post-range values for the appropriate targets.
¢ Define whether the genotype groups for each target will be determined automatically or
manually:

- Auto Determine # of Groups - If you are using automatic settings, select the
checkbox to have the software calculate the number of groups for the specific
target.

- Number of Groups - If you are using manual settings, enter the number of groups
for the appropriate targets.

¢ Remove all Manual Variants on reanalysis - Select to have the software omit from the
analysis all wells that have been manually been labeled as a variant.

Flag Settings Specify the quality measures that the Applied Biosystems" Software will compute during the
analysis.
1. In the Use column, select the check boxes for flags you want to apply during analysis.
2. If an attribute, condition, and value are listed for a flag, you can specify the setting for
applying the flag.
For example, with the default setting for the no amplification flag (NOAMP), wells are
flagged if the amplification algorithm result is less than 0.1.

Note: If you choose to adjust the setting for applying a flag, make minor adjustments as
you evaluate the appropriate setting.

3. Inthe Reject Well column, select the check boxes if you want the software to reject
wells with the flag. Rejected wells are not considered for data analysis.

4. When done modifying the analysis settings, click Finish.
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Review the quality  After the Applied Biosystems qPCR Analysis Software processes your project, you

data can use the Quality Control & Results screen to review the quality data generated by
the analysis. The software provides a variety of options to review the quality data;
however, the strategy that you employ will depend on the type of experiment you are
performing and the samples/targets that you are evaluating. The following procedure
describes a general approach to data review and provides an overview of the software
features.

1. If you have not already done so, click Analyze to analyze your project.
2. Click Quality Control & Results to view the Quality Control & Results screen.

3. Review the experiment data for quality flags generated during the analysis.

™

Note: The Applied Biosystems™ Software displays summaries of the quality
data in the margin beneath each experiment. You can view the identity of the
triggered flags by mousing over an experiment of interest.

Alternatively, to quickly find the experiments in your project that generated
quality flags, click = (Plate View), then click the Flags column heading to sort
the experiments that generated quality flags to the top of the table. To examine
the data that triggered the flag, click the corresponding link in the Name column.

In response to the presence of quality flags, consider the following resolutions:

* Change the quality settings in the analysis settings:

— Adjust the sensitivity of the quality flags so that more wells or fewer
wells are flagged.

— Deactivate the quality flags that triggered by the data.

* Omit individual wells from the analysis.

4. If flags or irregularities are present, or you would like to review the melt curve
data for a specific experiment, click the experiment of interest.

5. When viewing an experiment, display the Well Table:

Tool Use this tool to...

Select wells. To select:
e Anindividual well, select the well in the Well table.

e More than one well at a time, press the Ctrl key or Shift key

Mouse/cursor when you select the wells in the Well table.

When you select wells in the Well table, the corresponding data
points are selected in the amplification plot.

Omit/Un-Omit well from the analysis.
After you omit or un-omit a well, click Analyze to reanalyze the
project.

Actions menu For omitted wells, the software:

* Does not display data in the Well table (data are either
Unknown or empty/blank].

¢ Does not include the omitted wells in the analysis.

Expand or collapse the Well table by clicking the appropriate

forp symbol in the vertical bar between the plot and table.
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6. Review the data in the Well Table data.

Column Description
The location of the well on the reaction plate. For example, P18 indicates that the sample is
Well )
found in row P, column 18.
Omit The omission status of the related well.
The ID (a unique name or number) of the nucleic acid sequence targeted by the assay added
Target
to the well.
Sample The ID (a unique name or number) of the sample.
Task/Control The task assigned to the well, where the task is the function that a sample performs on the
plate.
Variant The call for the sample in well. Can be assigned by software (Auto) or manually.
Method The method used to apply the call to the well: Auto(matic) if calculated by the Applied

Biosystems" qPCR Analysis Software or Manual if user-applied.

Silhouette Score

The modified silhouette score calculated for the well, which measures distinguishably of the
associated melt curve relative to the other curves in the assay (Rousseeuw, 1987.).

For each melt curve, the software calculates a modified silhouette score, which ranges from
0 to 100. A score closer to 100 indicates that a melt curve is more similar to curves assigned
the same variant call than to curves called differently. Lower silhouette scores indicate that a
melt curve is less similar to curves assigned the same variant call.

IMPORTANT! The modified silhouette score differs from the standard silhouette score
(Lovmar, et. al., 2005.) in that the software assigns the score to each identified cluster

instead of to each data point in the cluster. In addition, the modified value ranges from 0 to
100.

The 1st, 2nd, and 3rd calculated melt temperature (Tm) for the well (if present).

Tm1/Tm2/Tm3 Note: Blank table cells indicate that the software calculated no Tm for the well at the
indicated position.
The amplification status for the well: amplification, no amplification, reviewed, and
Amp Status .
undetermined.
Amp Score The amplification score calculated for the well.
Cq Conf The Cq confidence score calculated for the well.
Ct The Ct calculated for the related well.
Ct Mean The arithmetic mean generated from the Cys calculated for the technical replicates of the
well.
CctSD The standard deviation generated from the Cts calculated for the technical replicates of the
well.
Flags The number of flags generated for the well.
Quality data The quality flags generated by the associated well.
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7. When ready, click € to return to the thumbnails view.
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Chapter 6 Analyze an HRM methylation study
Review HRM methylation data

The Aligned Melt Curves plot displays the melt curves as percentage melt (0 - 100%)
over temperature. The melt curves are aligned to the same fluorescence level using the
pre- and post-melt regions that you set.

. Display the Aligned Plot for the experiment of interest:

a. In the Applied Biosystems™ qPCR Analysis Software, select the Quality
Control & Results tab.

b. In the Quality Control & Results tab, select an experiment of interest, then
select all wells in the plate grid.

c. Select Plot » Aligned Melt to view the Aligned Melt Plot.

. Screen the negative controls to ensure that samples failed to amplify:

a. From the well table, select the wells containing a negative control to
highlight the corresponding melt curve in the Aligned Melt Curves Plot.

b. Confirm that the selected wells in the well table are negative controls, and
not unknown samples.

Samples that grouped with the negative controls may:
¢ Contain no DNA
¢ Contain PCR inhibitors
* Be homozygous for a sequence deletion

. If you run replicate reactions, carefully review your data set for curves that do

not align tightly with the other samples in the group (outliers). If outliers are
present, confirm the results of the associated samples by retesting them.

. Review the data:

¢ Methylated DNA standards — Do the melt curves for the methylated DNA
standards cluster well? Are there any outliers?

* Define methylation range for unknowns — Which methylated standard melt
curves are above and below the melt curves for the unknowns? For example,
if the melt curve for an unknown sample lies between the melt curves for the
5% and 10% methylated standards, the unknown sample contains between
5% and 10% methylated nucleotides.
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Review HRM methylation data

Review and adjust When you analyze an HRM experiment, the software calculates the Pre- and Post-melt

the pre- and post- regions using default settings. You can review and adjust the Pre- and Post-melt

melt regions regions to optimize your separation and variant calls. For most experiments, set the
Pre- and Post-melt regions as close as possible to the melt transition region.

About the pre- and post-melt regions

In the Derivative Melt Curves plot and the Raw Melt Curves plot, there are two pairs
of vertical lines before and after the data peak. These lines define the pre- and post-
melt regions used to scale the data in the Aligned Melt Curves and Difference Plot.

* Pre-melt region — The pair of lines to the left of the peak indicate the pre-melt
Start and Stop temperatures when every amplicon is double-stranded.

Fluorescence data from the pre-melt region corresponds to 100% fluorescence in
the Aligned Melt Curves Plot.

* Active melt region — The data peak indicates the active melt region of the plot.
Data from the active melt region are used to plot the Aligned Melt Curves Plot.

* Post-melt region — The set of lines to the right of the peak indicate the post-melt
Start and Stop temperatures when every amplicon is single-stranded.
Fluorescence data from the post-melt region correspond to 0% fluorescence in the
Aligned Melt Curves Plot.

Review and adjust the pre- and post-melt regions

1. Display the Derivative Plot for the experiment of interest:

™

a. Inthe Applied Biosystems™ qPCR Analysis Software, select the Quality
Control & Results tab.

b. In the Quality Control & Results tab, select an experiment of interest, then
select all wells in the plate grid.

c. Select Plot » Derivative Melt to view the Derivative Melt Plot.
2. Select Target » <assay> to view the melt data for the desired assay.

3. In the Derivative Melt plot, set the pre-melt region:

a. Click and drag the Pre-melt Stop temperature line (red arrow on the left)
adjacent to the start of the melt transition region.

b. Click and drag the Pre-melt Start temperature line (green arrow on the left)
approximately 0.2°C to 0.5°C from the Pre-melt Stop temperature line.

Note: The Pre-melt region should be within a flat area where there are no large
spikes or slopes present in the fluorescence levels.

4. Set the post-melt region:

a. Click and drag the Post-melt Start temperature line (black arrow on the
right) adjacent to the end of the melt transition region.

b. Click and drag the Post-melt Stop temperature line (yellow arrow on the

right) approximately 0.2°C to 0.5°C from the Post-melt Start temperature
line.
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Review HRM methylation data

Note: The Post-melt region should be within a flat area where there are no large
spikes or slopes present in the fluorescent levels.

5. Click Analyze.

The software reanalyzes the data using the new Pre- and Post-melt regions. The
colors of the melt curves change to reflect the new results.

Review the The Difference Plot displays the aligned data as the difference in fluorescence between
Difference Plot for  the melt curve for a reference sample and the other melt curves. You can select any

outliers control or well as a reference to subtract the selected curve from the others.

The Difference Plot allows you to more easily see small differences between curves
and identify outliers.

1. Display the Difference Plot for the experiment of interest:

a. In the Applied Biosystems™ qPCR Analysis Software, select the Quality
Control & Results tab.

b. In the Quality Control & Results tab, select an experiment of interest, then
select all wells in the plate grid.

c. Select Plot » Difference Melt to view the Difference Melt Plot.

2. From the Reference drop-down menu, select a control or any well as the
reference, then review:

* Variant clusters - How many distinct clusters are displayed?

* OQutliers - How tight are the curves within each variant cluster?

3. Repeat step 3 to review the data using the other reference samples to find the
optimal display of the clusters.

Confirm the The Applied Biosystems  qPCR Analysis Software calls each sample according to the
software calls shape of the aligned melt curves and the Tm. Review the software calls, then omit
outliers or change calls.

1. Display the Difference Plot for the experiment of interest:

a. In the Applied Biosystems™ qPCR Analysis Software, select the Quality
Control & Results tab.

b. In the Quality Control & Results tab, select an experiment of interest, then
select all wells in the plate grid.

c. Select Plot » Difference Melt to view the Difference Melt Plot.

2. From the View By drop-down list, select Well Table to review the calls generated
by the software.

3. In the well table, click the Well column header to sort the results according to the
well position.
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Review HRM methylation data

4. For the methylation standard controls, review:

¢ Variant Call column — Do all of the methylation standard controls have the
correct call?

* Confidence column - Are there any outliers within the replicate group? Do
the values for the replicate group differ from the confidence values for the
other replicate groups in the plate?

Note: If any of the controls are outliers, omit them from the HRM analysis, then
reanalyze.

5. Select the rows in the Results table to view the corresponding fluorescence data

in the Difference Melt Plot.
Perform manual Perform manual calls when you want to manually assign a sample to a variant group.
calls 1. In the Applied Biosystems™ qPCR Analysis Software, select the Quality Control

& Results tab.

2. In the Quality Control & Results pane, select the experiment of interest.

3. In the Review Result screen, select one or more wells within a Melt Curve Plot,
Plate Layout, or Well Table.

4. Click Actions, then select Manual Call.

5. From the Manual Call dialog box, you can assign the sample to:

* An existing variant call - Click Select Existing, select the appropriate call
from the Group drop-down menu, then click OK.
e A new variant call - Click Create New, enter a name for the new call in the
Group field, select a color, then click OK.

In the Plate Layout tab, the upper right corner of the sample well is marked with
a red triangle.
In the Well Table tab, in the Method column, Manual appears next to the selected
sample.

6. Repeat the steps above to assign more manual calls.

7. Click Analyze to reanalyze the data using the manual calls.
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(Optional) Sequence the variants

Omit wells from To omit the data from one or more wells that you do not want included in the
the analysis analysis:

* Select one or more wells in a plot or table, then click Actions » Omit. After the
wells are omitted, click Analyze to reanalyze the project without the omitted
well(s).

(Optional) Sequence the variants

After you identify the variants in the HRM software, dilute or purify the PCR product
from the HRM reactions, then sequence the variants. For more information on
sequencing the variants, contact Thermo Fisher Scientific.
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Troubleshooting

Troubleshoot the HRM calibration ............... ... i, 74
Troubleshoot an HRM experiment .............. ..., 74

Troubleshoot the HRM calibration

The following table contains common problems encountered during an HRM

calibration. For more detailed information, contact Thermo Fisher Scientific support.

Observation

Possible cause

Recommended action

Instrument does not eject the
plate

The adhesive cover may have
adhered the plate to the heated
cover within the instrument.

Unload the instrument.

Instrument malfunction

Multiple possible causes

Contact a local Thermo Fisher Scientific Field
Services office.

Troubleshoot an HRM experiment

The following table contains solutions to common problems encountered when
performing high-resolution melt experiments. For more detailed information, contact
Thermo Fisher Scientific support.

Observation

Possible cause

Recommended action

Late amplification: Ct value >30
for a majority of samples

The amplification reaction may
not reach the plateau phase.
HRM resolution may be
affected by the lower increase
in fluorescence.

Poor DNA quality.

Re-extract the DNA.

Amount of DNA added to the
HRM reactions is too low.

Perform PCR optimization, and increase
sample input or increase the number of
amplification cycles.

Messy HRM curves: Diagonal
wavy curves below
heterozygous clusters

HRM data from negative
controls and unamplified
samples skew the pre- and
post-melt curve settings and
interfere with the variant calls.

Negative controls and
unamplified samples are
included in the HRM analysis.

Omit negative controls and unamplified
samples from the HRM analysis.
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Troubleshoot an HRM experiment

Observation

Possible cause

Recommended action

More than three different
variant calls (HRM genotyping
experiments only)

If the target contains unknown
SNPs, multiple heterozygous
and homozygous amplicons can
be produced. If the amplicon is
too long, the melt curve may
have multiple melt regions
even without a SNP because of
the regional sequence context
of the amplicon.

The amplicon contains more
than 1 SNP.

Sequence the PCR product to confirm whether
the amplicon contains more than one SNP. If
the sequencing reveals more SNPs, redesign
the primers so that the amplicon contains only
one SNP.

The amplicon is too long.

Redesign the primers to reduce the amplicon
size.

Multiple melt regions: Complex
melt curves with multiple
melting regions

Complex melt curves are
difficult to interpret. If the
amplicon is too long, the melt
curve may have multiple melt
regions because of the regional
sequence context of the
amplicon.

The amplicon contains more
than one SNP (genotyping
experiments only).

Sequence the PCR product to confirm whether
the amplicon contains more than one SNP. If
the sequencing reveals more SNPs, redesign
the primers so that the amplicon contains only
one SNP.

The amplicon is too long.

Redesign the primers to reduce the amplicon
size.

Nonspecific amplification:
Decreased PCR efficiency and
multiple amplicons

Decreased PCR efficiency and
multiple amplicons may affect
the melting behavior of the true
target amplicons.

Incorrect salt concentration.

Perform a MgCl, titration to find the optimal
salt concentration for each reaction.

Primers are amplifying
multiple targets.

Perform a BLAST search to ensure primer
specificity. If the primers are not specific,
design new primers.

Reduce the number of amplification cycles.

After PCR amplification, consider running
some of the PCR product on a gel to make sure
that it contains a single band.

PCR inhibition: Amplification
curve with low slope and Ct
values higher than expected

The amplification curve has a
low slope and the amplification
reaction may not reach the
plateau phase. HRM resolution
may be affected by the lower
increase in fluorescence.

DNA sample contains
contaminants that inhibit PCR.

Dilute the samples 1:10 or 1:100, then repeat
the HRM reactions.

Incorrect salt concentration.

Perform a MgCl, titration to find the optimal
salt concentration for each reaction.

Reaction does not contain
sufficient enzyme.

Optimize the reaction using the MeltDoctor™
HRM Reagent Kit. You can add up to 0.15 U/puL
AmpliTaq Gold™ 360 DNA Polymerase to each
reaction.

Reaction does not contain
sufficient primer.

Optimize the reaction using the MeltDoctor™
HRM Reagent Kit. You can add up to 0.5 yM of
each primer to each reaction.

Amplicon is greater than 200
bp.

Increase the extension times during the
amplification reaction.

Primers are amplifying
multiple targets.

Perform a BLAST search to ensure primer
specificity. If the primers are not specific,
design new primers.

Reduce the number of amplification cycles.

Applied Biosystems™ High-Resolution Melt Getting Started Guide

75




Appendix A Troubleshooting

Troubleshoot an HRM experiment

Observation

Possible cause

Recommended action

Replicates are widely spread:
Sample replicates show a wide
spread in HRM curves

A wide spread within a
population leads to difficulties
in assessing true sequence
differences, particularly
between two different
homozygous populations.

Population spread

Use multiple controls for HRM analysis to help
you define the population spread.

Incorrect salt concentration.

Perform a MgCl, titration to find the optimal
salt concentration for each reaction.

DNA starting concentrations
vary widely between samples.

Make sure that the starting DNA
concentrations are similar for the samples that
you are testing.

Low PCR efficiencies.

Ensure efficient PCR.

Some late amplification: Ct
value >30 for some samples

Sample outliers with Ct values
that are greater than those for
the replicates also have a Tm
shift in the HRM curve. The
resulting Tm shift may affect
the variant call.

Reaction volume for the outlier
is visibly greater than or less
than the reaction volume for
the replicates.

Repeat the HRM reactions, and make sure that
you add the correct volumes to each well. Also,
after you seal the plate, spin the plate briefly.

Amount of DNA added to the
HRM reactions is too low.

Repeat the HRM reactions with more DNA in
each reaction.

PCR inhibition.

If the amplification curve also has a low slope
and all replicates for a sample are affected,
see "PCR inhibition: Amplification curve with
low slope and Ct values higher than
expected” on page 75 to troubleshoot PCR
inhibition in your HRM reactions.
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Prepare the HRM calibration plate

Required
materials

IMPORTANT! Before you can perform an HRM calibration, confirm that the region of
interest, background, and uniformity calibrations are current. For more information
on instrument calibration, see the user documentation for your Applied Biosystems™
QuantStudio™ 3 or 5 Real-Time PCR Instrument.

IMPORTANT! Perform a background calibration immediately before the HRM
calibration.

AmpliTaq Gold " 360 Master Mix, 1-mL (Pub. no. 4398876) or your master mix of
choice

Your custom dye

MeltDoctor  HRM Calibration Standard
MicroAmp " Optical Adhesive Film
Deionized water

Appropriate reaction plate
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Prepare the HRM calibration plate

Prepare a custom

HRM calibration
plate

78

. Add the required volumes of each component to an appropriately sized tube:

Volume (pL)
384-well plate | Fast 96-well plate SLLLEELCIAR L
Component plate
425 110 110
1 rxn. 1 rxn. 1 rxn.
rxns. rxns. rxns.
AmpliTaq Gold ™ 360 10 | 4250 | 10 | 1100 | 250 | 2750
Master Mix
Custom dye (20X]
(typical dye 1 425 1 110 2.5 275
concentration 0.1 pM
MeltDoctor™ HRM
Calibration Standard 1 425 1 110 2.5 275
(20X)
Deionized water 8 3400 8 880 22.5 2200
Total volume 20 8500 20 2200 50 5500

. Cap the tube, then vortex to mix.

. Spin the tube briefly.

for your instrument:

. Pipet the HRM calibration reactions to each well of an appropriate reaction plate

Reaction plate

Reaction volume

Fast 384-well plate

Fast 96-well plate

20 pL

Standard 96-well plate

50 pL

IMPORTANT! Accurate pipetting is required for proper calibration.

. Seal the reaction plate with optical adhesive film, then briefly centrifuge the

reaction plate to force the contents to the bottom of the wells.

. Verify that the liquid in each well of the HRM calibration plate is located at the

bottom of the well. If not, centrifuge the plate again at a higher rpm and for a

longer period of time.

IMPORTANT! Empty wells can cause the calibration to fail.
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Prepare a 96-well 0.2-mL HRM calibration plate

Prepare a 96-well 0.2-mL HRM calibration plate

Required
materials

Prepare the 96-
well 0.2-mL
custom HRM
calibration plate

This procedure is for preparing a 96-well 0.2-mL HRM calibration plate using the
MeltDoctor™ HRM Master Mix and MeltDoctor™ HRM Calibration Standard.

IMPORTANT! Use the HRM calibration plate immediately after preparing it.

IMPORTANT! You must perform the custom dye calibration and HRM calibration on
the same day that the HRM calibration plate is prepared.

Note: If you are using the MeltDoctor™ HRM Reagent Kit instead of the MeltDoctor™
HRM Master Mix, use the same component volumes in the HRM calibration plate that
you are using in your HRM reactions.

e MeltDoctor  HRM Master Mix

e MeltDoctor  HRM Calibration Standard
e MicroAmp  Optical Adhesive Film

e Deionized water

* 96-well 0.2-mL reaction plate

1. Add the required volumes of each component to an appropriately sized tube:

Volume (pL)
Component . 110 reactions (includes
1 reaction o
10% excess)

MeltDoctor” HRM Master 10uL 1100pL

Mix

MeltDoctor™ HRM TuL 110uL
Calibration Standard (20X)

Deionized water 9uL 990uL

Total volume 20pL 2200pL

2. Cap the tube, then vortex to mix.
3. Spin the tube briefly.

4. Pipet the HRM calibration reactions to each well of an appropriate reaction plate
for your instrument.

IMPORTANT! Accurate pipetting is required for proper calibration.

5. Inspect the plate to make sure all wells contain liquid.

IMPORTANT! Empty wells may cause the calibration to fail.
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Prepare the DNA templates

Seal the reaction plate with optical adhesive film, then spin the reaction plate.

. Verify that the liquid in each of the wells of the HRM calibration plate is at the

bottom of the well. If not, centrifuge the plate again at a higher rpm and for a
longer period of time.

Prepare the DNA templates

80

1.

4.

Purify all the DNA samples in an HRM experiment using the same method.
Watch out for salt carryover because it will subtly change the thermodynamics of
the DNA melting transition.

Perform agarose gel electrophoresis and spectrophotometry to make sure the
DNA template is intact and is not contaminated with other DNAs, RNAs,
proteins, or organic chemicals. Proteins and organic chemicals may inhibit the
PCR amplification, and contaminating DNAs and RNAs may result in sub-
optimal PCR performance or increased change of non-specific amplification.

Determine the quantity of DNA using spectrophotometry. If too little DNA
template is added to the reaction, the fluorescence signal may not be sufficient
for successful HRM analysis. If too much DNA template is added to the reaction,
the PCR may be inhibited.

(Optional) Dilute the DNA to 20 ng/uL.

Applied Biosystems™ High-Resolution Melt Getting Started Guide



Appendix B Supplemental procedures
Optimizing the reaction conditions

Optimizing the reaction conditions

If you want to optimize the reaction conditions, use the MeltDoctor™ HRM Reagent
Kit.

For more information on optimizing your HRM reactions, refer to A Guide to High
Resolution Melting (HRM) Analysis (Stock number O-081740 0509).

Table 1 Recommended component volumes for using the MeltDoctor™ HRM Reagent

Kit
Volume for one Final Acceptab!e
Components X . concentration
20-pL reaction | concentration
range
AmpliTaq Gold™ 360 Buffer, 10X 2.0 uL 1X 1X
25 mM Magnesium Chloride 1.6 uL 2mM 1.5t0 3.5mM
GeneAmp" dNTP Blend, 10mM 0.4 puL 200 pM each 100 to 300 uM
each
Primer 1 (5 uM) 1.2 uL 0.3uM 0.2t0 0.5 uM
Primer 2 (5 uM) 1.2 uL 0.3uM 0.2t0 0.5 uM
MeltDoctor™ HRM Dye (20X) 1.0 uL 1X 0.5X to 2X
AmpliTag Gold™ 360 DNA 0.4 pL 0.1 U/pL 0.05t0 0.15
Polymerase (5 U/uL) U/uL
Human gDNA (20 ng/pL) 1.0 L 1 ng/uL 10 pg/pL to 10
ng/uL
Deionized water 11.2 uL
Total volume 20.0 pL
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Documentation and support

Obtaining information from the Help system

The Applied Biosystems™ qPCR Analysis Software Help has a Help system that
describes how to use each feature of the user interface. Access the Help system by
doing one of the following;:

e Click in the toolbar of the Applied Biosystems™ qPCR Analysis Software Help
window.

¢ Select Help » Contents and Index.
® Press F1.

You can use the Help system to find topics of interest by:
* Reviewing the table of contents
¢ Searching for a specific topic
* Searching an alphabetized index

™

You can also access PDF versions of all documents in the Applied Biosystems™ qPCR
Analysis Help document set from the Help system.

Customer and technical support

82

Visit thermofisher.com/support for the latest in services and support, including:
* Worldwide contact telephone numbers

¢ Product support, including;:
— Product FAQs

— Software, patches, and updates
¢ Order and web support

* Product documentation, including:
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers,
contact the manufacturer.
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Documentation and support
Limited product warranty

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life
Technologies' website at www.thermofisher.com/us/en/home/global/
terms-and-conditions.html. If you have any questions, please contact Life
Technologies at www.thermofisher.com/support.
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Glossary

Calculation of the efficiency of the PCR amplification in a standard curve experiment.
EFF% is calculated using the slope of the regression line in the standard curve. A
slope close to -3.32 indicates optimal, 100% PCR amplification efficiency. To use
amplification efficiency in a gene expression project:
¢ On the instrument where you collected the comparative Ct (AACrt) data that will
be used in the project, run a standard curve experiment to determine the
efficiency.
* In the Applied Biosystems™ qPCR Analysis Software, enter the amplification
efficiency in the Efficiency table in the Relative Quantification Settings tab in the
Analysis Settings dialog box.

Display of data collected during the cycling stage of PCR amplification. The
amplification plot can be viewed as:

* Baseline-corrected normalized reporter (ARn) vs. cycle

* Normalized reporter (Rn) vs. cycle

A PCR reaction mix that contains primers to amplify a target and a reagent to detect
the amplified target.

An analysis setting for the Baseline Threshold algorithm in which the software
identifies the start and end cycles for the baseline in the amplification plot.

An analysis setting for the Baseline Threshold algorithm in which the software
calculates the baseline start and end cycles and the threshold in the amplification plot.
The software uses the baseline and threshold to calculate the threshold cycle (Cy).

In the amplification plot, the baseline is a cycle-to-cycle range that defines background
fluorescence. This range can be set manually on a target-by-target basis, or
automatically, where the software sets the baseline for each individual well.

Expression estimation algorithm (C,) which subtracts a baseline component and sets a
fluorescent threshold in the exponential region for quantification.

In experiments that contain data from real-time PCR, the magnitude of normalized
fluorescence signal generated by the reporter at each cycle during the PCR
amplification. In the ARn vs Cycle amplification plot, ARn is calculated at each cycle
as:

ARn (cycle) = Rn (cycle) - Rn (baseline), where Rn = normalized reporter
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See threshold cycle (Cr).
See threshold cycle (Cr).
See threshold cycle (Cr).
See Baseline Threshold algorithm.

A quality control (QC) indicator which, when applied by the software to a well during
analysis, indicates a possible issue with that reaction. A summary of the flags
identified in the project is displayed in the Flag Summary screen.

See no template control (NTC).

In the software, the task for targets in wells that contain water or buffer instead of
sample. No amplification should occur in negative control wells. Also called negative
control (NC).

An action that you perform before reanalysis to omit one or more wells from analysis.
Because no algorithms are applied to omitted wells, omitted wells contain no results.
You can add wells back in to the analysis; no information is permanently discarded.

A data point that deviates significantly from the values of an associated group (for
example, the other technical replicates for a sample).

An illustration of the grid of wells and assigned content in the reaction plate, array
card, or OpenArray " plate. The number of rows and columns in the grid depends on
the plate or card that you use.

In the software, you can use the plate grid to view well assignments and results. The
plate grid can be printed, included in a report, exported, and saved as a slide for a
presentation.

™

The Applied Biosystems™ qPCR Analysis Software organizes the analysis of
experiment data by project, which represents the association of the raw data, all
experimental setup information, and any associated settings used to perform the
analysis. Once created, projects can be shared with other users and transferred
to/from the repository.

Note: Projects to not contain the data from experiments uploaded to the repository;
they link the data for analysis without affecting the original data files.

A molecule attached to the 3' end of TagMan™ probes to prevent the reporter from
emitting fluorescence signal while the probe is intact. With TagMan™ probes, a
nonfluorescent quencher-minor groove binder (NFQ-MGB) can be used as the
quencher.

Identical reactions containing identical components and volumes.
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A fluorescent dye used to detect amplification. With TagMan™ reagents, the reporter
dye is attached to the 5' end. With SYBR™ Green reagents, the reporter dye is SYBR™
Green dye.

See normalized reporter (Rn).
A dye used as the passive reference.

The reaction volume and the thermal profile (thermal cycling parameters) for the
instrument run.

The biological tissue or specimen that you are testing for a target gene.
In the software, the type of reaction performed in the well for the target.

Reactions that contain identical components and volumes, and that evaluate the same
sample; important for evaluating precision.

The part of the run method that specifies the temperature, time, ramp, number of
cycles, and data collection points for all steps and stages of the instrument run.

In amplification plots, the threshold is the level of fluorescence above the baseline and
within the exponential amplification region. For the Baseline Threshold algorithm, the
threshold can be determined automatically (see automatic threshold), or it can be set
manually (see manual threshold).

The PCR cycle number at which the fluorescence meets the threshold in the
amplification plot.

In the software, the task for the target in wells that contain the sample being tested.
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